## Contents

### Chapter 1: Key Relationships ......................................................... 1
- Welcome to Sage 100 Contractor and Your Business .................................. 1
- About Key Relationships ............................................................................ 1
- Production Activities Specialized for Contractors ........................................ 3
- Accounting Activities Specialized for Contractors ....................................... 6
- Analysis Specialized for Contractors .......................................................... 10
- Communications Specialized for Contractors .............................................. 11

### Chapter 2: Underlying Concepts ....................................................... 13
- Underlying Job-related concepts ................................................................. 13
- Underlying Accounting-related concepts .................................................... 15

### Chapter 3: Additional Details ........................................................... 19
- General Operational Features ................................................................. 19
- Accounting Details ...................................................................................... 29
- Analysis Details .......................................................................................... 32
- Accounts Payable Details .......................................................................... 33
- Accounts Receivable Details ....................................................................... 34
- Document Control Details ......................................................................... 43
- Equipment Management Details .................................................................. 43
- Estimating Details ....................................................................................... 44
- Inventory Details ......................................................................................... 46
- Payroll Details .............................................................................................. 46
- Production and Project Management Details .............................................. 63
- Reporting Details ........................................................................................ 68
- Scheduling Details ....................................................................................... 71
- Service Receivables Details ....................................................................... 72

### Chapter 4: Customer Resources .......................................................... 75
- Sage 100 Contractor Printable Documentation ............................................ 75
- Customer Support and resources ................................................................. 76
- Training resources ....................................................................................... 78
Contents

Business partners ....................................................................................................................... 79
Business forms .......................................................................................................................... 79

Index ........................................................................................................................................ 81
Chapter 1: Key Relationships

Welcome to Sage 100 Contractor and Your Business

Welcome to Sage 100 Contractor. Sage 100 Contractor is an integrated, construction-specific, estimating, accounting, and project management software solution. Whether you are a general contractor, a subcontractor, or service contractor, Sage 100 Contractor manages your business using one system.

Sage 100 Contractor provides many features that are beneficial for customers with complex environments that may include remote connections, many simultaneous users, and/or multiple companies.

Tools in Sage 100 Contractor can help you run a more profitable business. As with any powerful tool, it’s best to take advantage of training opportunities to help increase your understanding Sage 100 Contractor. With that understanding, you will become an efficient and effective user.

Reading this book, Sage 100 Contractor and Your Business, is one way to start your Sage 100 Contractor training. It is not intended to show you specific installation steps or the how-to of program use. Instead, it leads you through three levels of concepts important to understanding how Sage 100 Contractor works. This book provides a bridge from the highest level overview of Sage 100 Contractor to a more detailed level. It provides the insights necessary to help you work effectively with a business partner while working through business implementation issues.

About Key Relationships

Key relationships in Sage 100 Contractor are in five major areas and are explained in further detail:

- Initial acquisition of your customer – sales, estimating, and proposals.
- Production activities specialized for contractors – these include the items that get the work done: POs, schedules, change orders, and more.
- Accounting activities specialized for contractors – AP, AR, Payroll, and more that are designed with the contractor in mind.
- Analysis specialized for contractors – near real-time analysis of jobs, job profitability, and the overall health of your business.
- Communication with your business partners – use the outputs and products of the prior four areas in a full array of communications.

As you read these topics, note that they are in the order you typically will follow for a construction job. Some of the groundwork for how you implement Sage 100 Contractor is discussed in the section, “Underlying Concepts.”

Acquiring Your Customers

Acquiring your customers is generally the first step as you work through the normal business cycle. With Sage 100 Contractor, you can use existing prospecting and sales methods in your company or build upon Sage 100 Contractor and third-party capabilities. After finding your prospects, use the estimating tools of Sage 100 Contractor or your current system to develop estimates that will drive proposals, production, and job analysis.
Chapter 1: Key Relationships

The components of acquiring your customers (sales, estimating, takeoffs, and proposals) are discussed in more detail in the next few paragraphs.

Sales

Sage 100 Contractor provides solid sales management and tracking. With a client database, you can use Sage 100 Contractor to manage sales leads from the first contact to signing the contract. In each client record, you can assign a salesperson to be responsible for managing the client and to keep comprehensive notes about the client over the course of the sales process. Using the lead source list and the unique client reports, you can see how advertising and promotions are generating leads and closing sales.

Determining when to place follow-up calls is another important aspect of sales and client relations. To streamline the follow-up process, a salesperson can enter a callback date in a client record. Based on a callback date, the salesperson can quickly generate a list of clients to call for the next day or week, making the follow-up process simple and efficient.

After a contract or work order has been issued, the client database becomes an important part of making repeat sales, renewing service contracts, and other selling opportunities.

In addition, integrated applications from third-party vendors can provide more advanced CRM and sales management tools.

Estimating

After identifying a prospect, the next step in acquiring a customer is creating an accurate estimate of the work for the prospect.

Sage 100 Contractor Estimating supports good business practices by:

- Helping you manage risks by explicitly including risk factors for all elements of a bid or by using different billing methods.
- Helping you delineate the bid you present your customer from the budget that measures your costs.
- Helping you manage labor with measurement and control of both hours and burdened labor costs.

The Estimating add-on module makes the estimating process fast and accurate. It is fully integrated with scheduling, project management, and accounting functions. Because it combines the best features of a database and spreadsheet, the Sage 100 Contractor Estimating module offers one of the easiest-to-use, assembly-based estimating solutions on the market today.

Estimating can be the start of your production activities by creating items such as budgets, proposals, purchase orders, and subcontracts.

There are many third-party estimating tools available that work with Sage 100 Contractor, thus extending Sage 100 Contractor’s integrated accounting and project management tools to meet the special needs of your trade.

For details of Sage 100 Contractor’s estimating process, see the sections about Takeoffs and Assembly. Estimating is an add-on module, but you may be able to integrate your own estimating methods into Sage 100 Contractor.
Takeoffs

A takeoff is the Sage 100 Contractor concept that encompasses building an estimate. This functionality is a key to starting the Sage 100 Contractor profit cycle. You can use bid items and job phases to organize your projects. Then, using the parts and assemblies databases, you can quickly build a takeoff for any project. The takeoff is how you translate your customers’ needs into estimates of material, labor, subcontracts, and other costs.

Once completed, you can examine the anticipated project costs through a variety of takeoff reports. You can also export the information to automatically create budgets, proposals, change orders, purchase orders, and even service work orders.

If you have an estimating system that is trade-specific and works for you, you can import the estimate from that system and then use the rest of Sage 100 Contractor to run your business.

Takeoffs are part of the Estimating add-on module.

Proposal

The proposal is a document presented to a client, providing a breakdown of the contracted amount by cost code or bid item. Sage 100 Contractor provides several ways to create a proposal: you can export the data from a takeoff, import a budget, import a file, or create a proposal manually.

Using a variety of custom-designed document formats, you can then print the proposal, enabling you to produce the most professional and complete proposal possible.

Proposals can take advantage of Sage 100 Contractor's form design tool. With the form design tool, it is easy to build and customize a multi-page proposal that includes a cover sheet, the contract, and itemized price sheets for specific job requirements.

Once the proposal is completed, you can set the original proposal. After negotiating the price with your client, you can edit the current proposal and compare it with the original.

If it becomes necessary to adjust the selling price in a proposal, you can create change orders to track the extra work and revenue. Change orders allow you to alter the selling price independent from the proposal itself.

Production Activities Specialized for Contractors

About production activities specialized for customers

Sage 100 Contractor excels at the production activities you need to successfully deliver your jobs. The results of the production activities are automatically entered into accounting systems so you do not have to waste time with duplicate data entry.

Production

After estimating and securing a job, production activities ensure the timely and profitable delivery of a job. A few key controls can help you track your production:
• Controlling change orders is vital. Don’t lose track of this source of added profit.
• Controlling schedules can help you complete jobs more timely with lower overhead per job. You’ll also keep subcontractors happy with up-to-date schedules.
• Controlling materials can make sure all the parts needed for specific tasks are on-site when needed.

Beyond these key items, Sage 100 Contractor encompasses the following as part of production:
• Proposals
• Budgets
• Job cost
• Scheduling
• Purchase orders
• Subcontracts
• Change orders
• Automated cost-to-complete analysis
• Equipment management
• Document control

You can use reporting to identify and correct areas that need management attention.

Schedule

Using 10-Scheduling, you can create a schedule to plan and manage a project, regardless of its size. A schedule allows you to budget time, plan when some tasks begin in relation to other tasks, and set milestones. You can also set up tasks for billings or inspections and identify scheduling conflicts between resources. You can analyze the accuracy of time estimates, track the progress of jobs, and adjust tasks or resources to keep projects on schedule.

Purchase Order

A purchase order lists the materials needed from a specific vendor for a specific job. You can create purchase orders manually for each vendor, or export data from the takeoff to create purchase orders automatically for each vendor. In addition, you can create purchase orders for the subcontractors on a given project.

With large projects, you can create master purchase orders. A master purchase order contains all the parts needed from a vendor, but allows you to create smaller purchase orders to help schedule the flow of materials to the job site. For instance, you can stagger the purchase and delivery of framing materials to better coincide with the different phases of construction.

After creating purchase orders, you can generate job cost reports to determine committed costs. As you receive shipments of materials, employees can enter the quantities of materials received using purchase order receipts, which create a payable invoice. When you receive the payable invoice from the vendor, you can review the invoice record and make any necessary adjustments.

You can use a vendor-specific warning system to prevent you from paying an invoice without entering a PO number or to alert you if an invoice exceeds the PO amount. In addition, PO audit reports indicate overcharges on any line of the PO so that you won’t mistakenly overpay, even for small items.
The program provides the functionality to attach POs to email messages or fax them to vendors.

**Subcontract**

Many contractors use subcontracted labor to perform specific types of work, such as electrical wiring, plumbing, framing, sheetrock, and so forth. Using subcontracts along with change orders and invoicing, you can create and monitor subcontracts, review change work, and create invoices that affect subcontracts to gain tighter control of subcontract billings.

You can export items from a takeoff to automatically create subcontracts, or you can enter the subcontracts manually. You can review billings, approved and open change orders, or a summary of the subcontract information.

You can also set up retention for a subcontract. When you create an invoice for the subcontract, Sage 100 Contractor uses the rate indicated in the subcontract record.

**Request for Proposal**

A Request for Proposal (RFP) is a document you send to vendors or subcontractors containing a list of parts needed or work to be performed. The vendor or subcontractor uses the RFP to create a proposal for you containing a list of parts needed or work to be performed.

Sage 100 Contractor supports RFP and RFI numbering by job, and if the job has phases, by job and phase. This feature makes it easier to keep track of RFIs and RFPs because they are associated with the job in which they were initiated.

RFPs can be generated directly from the takeoff screen. A number of key date fields allow you to manage RFPs through the bidding process. When accepted, you can easily turn RFPs into purchase orders.

**Change Order**

Change orders provide powerful tools for managing changes to a prime contract or subcontract. Change orders allow you to track changes independent of a project’s budget, providing a clear audit trail for pending, approved, and refused changes.

Depending on the type of change work you need to perform, you can enter change orders that alter the job’s budget, proposal, or subcontracts, or any combination of the three. You can enter changes to costs that affect the bid amount. Then you can enter cost changes that affect your budgeted costs such as subcontract changes, or work for which you do not want to charge the client.

Change orders are now more closely integrated with subcontracts. When you create a change order for a subcontract, information is displayed on the subcontracts window in columns. This tight integration provides more control over your contracts and your invoicing by providing easily accessible information.

**Service Management**

Service Management includes service contracts, service routes, service dispatch, on-call work orders and quotes. Because service management functionality fully integrates with the inventory, you will be able to keep inventory up-to-date when service work is performed.

Service client data supports multiple locations for every client and lists of installed equipment at every location so that you can track what was done on any piece of your client’s equipment.
As you create records, you can use the dispatch board to schedule the service call and provide the location of the work and the parts and assemblies necessary to complete the work.

When performing service work for insurance recovery, you can also supply necessary policy details. Service Management is part of the Service Receivables add-on module to Sage 100 Contractor.

**Project Management**

Project Management includes most of the tools in the production portion of the profit cycle. The specific project management tools that come integrated as part of Sage 100 Contractor are:

- Budgets
- Job cost setup and job cost management
- Job cost and budget reports
- Purchase orders
- Subcontracts
- Change orders
- Cost to complete tools
- Proposals
- Unitary proposals
- The Project Work Center
- Document control

Project Management is part of the core Sage 100 Contractor system.

**Document Control**

Using document control functionality, you can track important project management documents and maintain complete control of every item needed for a project. Requests for information (RFIs), requests for proposal (RFPs), transmittals, submittals, daily field reports, and correspondence all integrate with estimates, change orders, purchase orders, subcontracts and payroll, thus making the process of project management complete, fast, accurate, and reliable.

You'll be able to manage correspondence, keep track of project plans, maintain a project hot list, and stay on top of punch list items. A customizable template makes daily field reports accurate and easily accessible.

Document Control is located under Project Management.

**Accounting Activities Specialized for Contractors**

**Accounting for Construction**

Fully integrated accounting with automated job costing is the backbone of Sage 100 Contractor. Sage 100 Contractor accounting meets accounting needs and your special needs as a contractor. Sage 100 Contractor accounting includes:
Managing key compliance issues such as workers’ compensation, liability insurance, bonding, and more.

- Distinguishing between overhead and direct costs, and then comparing budget to actual job costs.
- Driving job control through purchase orders. Job costing is not dependent upon accounting staff but starts when the information is generated by project managers.
- Billing easily in a variety of ways so generating income is an easy part of your operation.

The accounting system includes:

- General ledger
- Accounts receivable (with many invoicing options)
- Accounts payable (bill paying)
- Payroll (with direct deposit)
- Equipment costing and management

Add-on modules that are integrated with accounting are:

- Estimating
- Combined Service Receivables and Inventory

Sage 100 Contractor integrates all estimating, production, and analysis tasks fully with the accounting system. A major key to this integration is the ability to track all job estimates, costs, and committed costs. Then you can use standard reports or create new ones so you always track your profit and loss from each job.

**General Ledger**

The General Ledger forms the backbone of the accounting system. It receives information from all functions that affect the accounting process, including accounts receivable, accounts payable, payroll, inventory, and service receivables. You also can make entries directly into the general ledger for cash, checks, deposits, journal transactions, and recurring transactions.

The General Ledger supports up to 10-digit account numbers. True subsidiary ledgers are maintained so that financial statements are simplified.

All 12 accounting periods for the year as well as the twelfth period of the prior year are available for posting, and you may control posting to any period. Entries made to the prior year will automatically update the prior-year ending balances as well as the current year beginning balance.

You can print custom financials and multi-company financials as well as standard accounting reports at any time for any period. A bulletproof audit trail creates a secure system from accounting to job costs, complete with automatic auditing of all stored balances back to their original entries.

**Accounts Receivable**

The Accounts Receivable system serves as a marketing, sales contact, and document management tool, as well as a means of managing receivable accounts. The client database contains sales information for tracking prospects from the first point of contact to the close of a contract and completion of a job. Client documents includes standard sales letters, notifications, and other client related forms. For each client, actual work is associated with jobs. Jobs are discussed in more detail in *Chapter 2: Underlying Concepts*.
Four special billing options are available for Accounts Receivable—progress billing, unitary billing, loan draws, and time and materials billing.

Statements and other documents contain full contract summaries. You can add any information from the job or client databases to these documents. Call sheets and aging reports are also available for efficient collection management and processing. You can produce aging reports at any time, which can be "as of" the end of any prior fiscal period to match financial reports for the same period.

Accounts Receivable is part of the core Sage 100 Contractor system.

**Accounts Payable**

The Accounts Payable system is fully integrated with purchase orders, subcontracts, job cost, and inventory. You can complete your entire invoice entry in one step when you enter a purchase order or subcontract number. Sage 100 Contractor compares each line of the invoice to the purchase order, preventing over-pricing or over-delivery of items without your approval.

By tracking expiration dates on Workers’ Compensation, liability insurance, and contractor licenses, Sage 100 Contractor can warn you before you pay subcontractors who have not supplied you with current documentation. In addition, you can track each subcontract separately to prevent payment if there is a dispute over the contract.

You may select from a wide variety of check formats or create your own. Choose multiple check stubs or special check reports to list all of the invoices paid. You can make a partial payment or designate dual payees on any invoice, and decide which credits to apply to a payment prior to running checks. You can even override discount dates to take discounts that have expired.

Aging reports can be run as of the end of any prior period to match financials even after the period has been closed. Compliance reports and 1099 forms are also included in the extensive reporting options.

Accounts Payable is part of the core Sage 100 Contractor system.

**Payroll**

5-Payroll is one of the core modules provided with Sage 100 Contractor that helps provide complete integration with job costs. The payroll functionality includes many cost savings features, such as handling complex workers’ compensation. In addition, the program provides functionality for working with local taxes, payroll groups, union payrolls, certified payroll, and multiple ways to enter your data.

Payroll automatically generates accurate labor costs by calculating all your accruals as well as basic pay items on a line-by-line basis for every timecard. You will get the most accurate cost of payroll possible. Even liability insurance and small-tool costs can be included in the payroll calculations and automatically posted to job costs. You also can include any of the standard 401(k), “cafeteria,” and qualified benefit plans to save money on payroll taxes and workers’ compensation.

Payroll supports all workers’ compensation systems, including split rates, hourly calculations, and in some states employee and employer portions. Special reports are available for states with different workers’ compensation calculations, such as Nevada, Oregon, and Washington.

For large payrolls, Sage 100 Contractor provides daily field and staffing reports. Daily Payroll can be integrated with equipment management for allocation of equipment repair time and equipment cost to projects.
**Equipment Management**

Equipment management is an integral part of maintaining a profitable business. The ability to analyze equipment costs ensures that you not only recover costs but also make the equipment profitable. With the Equipment module, you can track a variety of ownership costs including loans, loan payments, and maintenance as well as examine equipment costs and revenue.

For each piece of equipment, you create an equipment record to track important information such as loans, cost rates, rental rates, and depreciation. In each equipment record, you can set the rate at which you recover costs for the equipment.

As you use equipment, allocate the equipment time to jobs or to other equipment for repairs. Suppose that a backhoe is used to lift the engine out of a bulldozer for repairs. The program creates an equipment-cost record for the use of the backhoe based on the cost recovery rate and the length of time it was used. When you allocate the backhoe to a job, the program creates job cost and revenue records. With a database of job cost and revenue records, you can then analyze the profitability of your equipment.

**Inventory**

The Sage 100 Contractor Inventory control system lets you keep track of the inventory flow, from the time you receive it, to the time you consume it. Inventory control helps track how much of a particular item you have in stock, where it is located, how many are committed to jobs, and even how many to reorder when stock is low.

The inventory control system is integrated with the rest of Sage 100 Contractor. When you enter payable invoices, service receivables credits, or purchase order receipts, the program moves the parts into inventory, even individually serialized parts. In the **9-2 Parts** window, you can select a part and view how much stock is on hand, how much is available, and to which locations it has been assigned. When you create service invoices, Sage 100 Contractor automatically removes the parts from inventory. You can also manually remove parts and job cost them using Inventory Allocation.

Service Receivables and Inventory are a combined add-on module.

**Service Receivables**

Service Receivables includes quotes, point-of-sale and billing-of-service work and materials. Because Service Receivables is fully integrated with Inventory, you will be able to keep inventory up-to-date as you invoice service work.

Service Receivables includes quotes, point-of-sale and billing-of-service work and materials. Because Service Receivables is fully integrated with Inventory, you will be able to keep inventory up-to-date as you invoice service work.

Service Receivables functionality helps you quickly enter work orders, invoices and credit transactions that affect service receivables accounts. You can create quotes, work orders, invoices, credits, and service routes and contracts. You can also view many different summaries such as service contracts for clients, client equipment, equipment by location, quotes, work orders, and open invoices.

Service Receivables integrates with payroll so you can directly import hours from your service work orders.

When performing service work for insurance recovery, you can also supply necessary policy details.

Service Receivables and Inventory are a combined add-on module.
Analysis Specialized for Contractors

Analysis

Now let's consider the concept of job analysis. Many contractors tend to think of jobs independently. Sage 100 Contractor has the tools for you to analyze each job and apply the insights learned to the next job. You can analyze single jobs while you are working on them. You can also use such tools as the committed cost or cost to complete reports.

Then as the job is nearing completion, as part of your job closing workflow you can:

- Create, manage, and clear punch lists
- Review all job costs, especially those unbilled from vendors
- Ensure that all change orders have been billed to the customer
- Compare job costs to budgets

When you have completed a job, you can then contrast and compare groups of jobs. In addition to comparison reports, Sage 100 Contractor provides graphical project review analysis where you can visually compare various selections of jobs.

For your business as a whole, Sage 100 Contractor provides financial review with a wide range of key charts that can be viewed or printed in line, bar, or 3D bar for current year, 12-month or 12-month rolling periods. Among the many graphs available are current ratio, quick ratio, gross profit/sales, net profit/sales, and overhead to direct expense. In addition, trend graphs are available for cash, accounts receivable, accounts payable, sales, gross profit, net profit, break-even, and working capital.

With over 1200 reports, Sage 100 Contractor provides you with the tools to analyze your business the right way for you. If you do not find the exact report you need, you can turn to the Report Writer and develop the report you want. To complete complex reports, you may wish to consult with a business partner.

Report Writer

The Sage 100 Contractor Report Writer allows you to create custom reports that access information stored in the Sage 100 Contractor databases. With Report Writer, you can modify existing reports or create altogether new reports for your company needs.

Before using the Report Writer, however, review existing Sage 100 Contractor reports to see if there is one that you can adapt your processes to use. With over 1200 reports, Sage 100 Contractor probably has one to suit your needs.

The Report Writer has a wizard that walks you through the process of creating your own reports. You can use most standard reports as a starting point for creating your own.

Query

Queries are a powerful feature for analyzing your data and your business. When you query a database, Sage 100 Contractor locates all the records that match your criteria and displays the results in a Quick Report window. You can then use drill-down capability to select a record for review. You can also copy the results of a query into a spreadsheet. Queries are supported by a Query Wizard to get you started with a minimum of effort. Queries are a key feature for customizing Sage 100 Contractor for the way your business runs.
Dashboard

Sage 100 Contractor has a powerful feature called the Dashboard. The Sage 100 Contractor Dashboard has been designed for busy construction executives. At a glance, it shows you the state of your company’s finances in real-time by displaying information under seven major category headings.

To enhance the power and flexibility of the Dashboard and Sage 100 Contractor accounting in general, you can now drill down into Sage 100 Contractor financial reports from the Dashboard, and from those reports to other reports or transactions within Sage 100 Contractor windows.

About program-wide drill-down into report information

Sage 100 Contractor provides over 1,200 in-product reports that can help you to analyze your business from many different perspectives. In addition, most reports enable you to “drill down” from the values presented on the report to the underlying information.

If there is drillable information on that page of the report, your pointer resembles a magnifying glass. When you move the pointer over values on the report, if the lens displays a red circle, you can drill down from that value to the underlying information.

Examples of Drilling Down into Report Information

Note: In the following examples, Sage 100 Contractor is running the Sample Company, menu 3-1-3 Receivable Aging, and the 31-Current Job Aging report. The report was run without selection criteria.

Communications Specialized for Contractors

Communications capabilities are available throughout Sage 100 Contractor. You can stay in touch with:

- Clients
- Prospects
- Employees
- Vendors
- Subcontractors
- Architects
- Engineers
- Banks
- Government agencies
- Unions
- Insurance companies, and more.

For each of these audiences, you will find that Sage 100 Contractor provides specialized and customizable reports and forms from every functional area of the system. These reports and forms are designed with the contractor in mind. For instance, you can print contracts with detail notes automatically imported from takeoffs.
Chapter 1: Key Relationships

As discussed in related topics, Sage 100 Contractor provides the means to fax and email all these communications to your business partners. With Scheduled Reporting, you can have these communications take place automatically, at any time of the day.

You can also communicate by sharing files. Some areas of Sage 100 Contractor provide specialized formats but you can also use the export to excel capability discussed as part of analysis.

Attachments provide functionality to attach files and/or Web links to selected records in Sage 100 Contractor. You can simply drag and drop files and/or Web links onto Sage 100 Contractor windows that accept attachments, such as AP invoices, subcontracts, and requests for proposals.

Finally, a much larger world of communications is opened when you use the Sage 100 Contractor Application Program Interface (API) with specialized third-party programs.

Report Scheduling

Report scheduling provides the functionality so that you can schedule most reports to print at a specific time and for a given frequency. You can also specify the output options (print, fax, or email) for the report and determine to whom it should be sent. There are specific system requirements for faxing and emailing reports.

This powerful tool gives you the ability to control and manage your data on a regular basis. It provides specific reports and forms that you can send directly to your vendors, clients, and employees.

You can specify whether the report should be sent to the printer, a fax distribution list, or an email distribution list. You can specify when and how often the report should be run. Recurrence lets you designate a specific end date for the report or the total number of times that the report should be generated. For email and fax reports, you can include a subject line and message.

Scheduling is not possible for reports that print checks, post to general ledger, or require secondary input.

Emailing and Faxing

Emailing and faxing from Sage 100 Contractor provide the communications tools you need to get information to your business partners and staff when they need it. You can email or fax almost all reports from Sage 100 Contractor to either a single person or to a full distribution list.

You can email and fax as you create reports. Using the report scheduling feature, you can have email messages and faxes sent at specific times and on a recurring basis.

Note: For all the details about faxing from Sage 100 Contractor, see the Installation and License Administration Guide.

Application Programming Interface (API)

An API is a set of programming tools for developers to interface to a specific application. Many programs provide APIs to allow third-party developers the capability to integrate with and extend the basic capabilities of the program.

For further details about joining the Sage CRE Development Partner Program, visit


12 Sage 100 Contractor
Chapter 2: Underlying Concepts

Underlying Job-related concepts

About underlying job-related concepts

Before you continue your Sage 100 Contractor education with function area information, there are a few important topics you need to know about. The topics discussed in this section are very important because your choices and understanding about them will influence every area of Sage 100 Contractor. If you are unclear about any of these topics or why they are important, be sure to talk to your business partner or take the appropriate training classes.

Job-related concepts and job costing

Jobs and job costing are key components of Sage 100 Contractor. Many aspects of the system are set up to support job costing. Good job costing helps produce some of the most important benefits of Sage 100 Contractor, such as budget to actual reports and job profitability analysis.

Cost Code

Cost codes are an important part of the job costing system. They allow you to separate costs into different categories and compare budgeted costs to actual cost for a job. Each cost code is assigned to a division, which provides a way to group cost codes for subtotaling on reports. Sage 100 Contractor organizes job costs in order of detail by job and phases, cost codes, and cost types.

When you set up a list of cost codes, Sage 100 Contractor uses the list throughout the entire company; all construction projects use the same list. Because the cost code structure relates to an individual company’s estimating and cost gathering methods, you can create a different cost code structure for each company. However, using different cost codes for the same type of work performed across different projects or companies can prove confusing and potentially cause inaccurate data.

You can also assign workers’ compensation codes and departments to cost codes, providing default information during timecard entry. The workers’ compensation code ensures that you correctly assign compensation codes for work performed. For states with split rates, you can also set up a wage maximum and a second compensation code.

The cost code can contain a department, which the system will find while looking at the job record during timecard entry. If the cost code does not indicate a department, the program will then look at the employee position for information.

Job

In Sage 100 Contractor, a job encompasses the work and materials for a specific project for a specific customer. Simply speaking, the job is where you do the work, and the client is where you send the invoice. For each job, Sage 100 Contractor stores and develops the job-related information such as important identifying information, contract dates, job balances and costs, and contract terms. In addition, job functionality provides a variety of tools to help manage contracts. You can supply information for creating pre-liens and lien releases, and create phases to divide work into more manageable sections. You can also create bid items to divide the estimate into more measurable or customer-required sections.
Chapter 2: Underlying Concepts

You can also provide billing information such as the client, job architect, engineer, or project lender. For instance, when you supply the client number, the program includes the client information on invoices printed for that job. If you include the architect or engineer name in the job record when using progress or unitary billing, the program uses that information when creating a progress or unitary bill. If you include the lender, the program uses the lender information when creating a loan draw document.

**Job Cost**

Job costs are the detailed cost records about a specific job. Accurate job costs provide the way to analyze costs and refine the estimating or budgeting process. When you post a transaction to the Direct Expense or WIP range of accounts, Sage 100 Contractor prompts you to create a job cost record.

**Overhead**

Overhead costs are those costs that cannot be job-costed. Sage 100 Contractor supports direct allocation of a wide range of costs to jobs. A great many costs that once required an additional journal entry to allocate to jobs can be added as labor burden rates within the payroll system. These can include items such as vacation accrual or small tool expense. The daily field reports make it easy to capture job-specific equipment use.

A goal for many Sage 100 Contractor customers is to move all variable overhead to specific job costs. For developing estimates and budgets, specific overhead rates can be set by bid item, by cost type, and by direct assignment in takeoffs; this capability is only available if you have purchased the Estimating add-on module.

**Cost Type**

Cost types allow you to arrange costs into categories. Each cost code acts as a controlling account for the nine cost types. Cost types will be displayed on grids throughout the system. Five cost types are defined by the system: material, labor, equipment, subcontract, and other.

Cost codes are key to accurate budget reports. You can set up Sage 100 Contractor to provide budget verification. The program then compares the cost codes in the timecard against the cost codes in the budgets. When you save the record, the program notifies you if a line item does not appear in the budget of a job.

**Division (Cost Code)**

Divisions allow you to group cost codes. Because Sage 100 Contractor uses divisions to subtotal costs for cost-based reports, many contractors create divisions based on the Construction Specifications Institute (CSI) structure. You do not, however, have to rely on the CSI structure for divisions and can create your own.

**Phase**

Using phases in a job affects all its aspects, such as job schedules, the job budget, all document control, purchase orders, subcontracts, change orders, proposals, project management reports and analysis, job costs, change orders, payables, and billing. Phases organize jobs and can represent different sections of a job, such as different buildings or lots. You can also use phases to distinguish different types of work, such as change orders or site work. Using phases does not restrict which billing methods you can use; in fact, you can use them with time and materials billing or change orders.

Project phases are defined in accounts receivable when you set up jobs, but then flow through Sage 100 Contractor.
Budget—Job

A budget represents a summary of the expected hard costs detailed in a takeoff and provides the basis for all budgeted versus actual cost, hour, or unit comparisons. In addition, you can use the budget as the basis for the proposal you provide the client.

The costs for a budget are categorized by cost code, and each cost code is further divided into cost types. Furthermore, you can include the hours necessary to complete the work for each cost code. For work performed on a unit basis, include the quantity of units to be performed for each cost code; the program automatically computes the cost per unit.

There are several ways to create a budget: you can export the data from a takeoff, import a file, or create a budget manually. Once the budget is completed, you can set the original budget. If at any point the budget is changed, you can compare it to the original.

If it becomes necessary to adjust the costs in a budget, enter the changes by issuing change orders instead of changing the original budget. Change orders allow you to alter the budgeted costs independent from the budget itself.

Underlying Accounting-related concepts

About underlying accounting-related concepts

You need to understand the accounting related topics below before setting up any component of Sage 100 Contractor. A clear understanding of these topics will ensure that you set up a general ledger that will work for your business. These topics will also give you insight into some of the operational processes that are part of Sage 100 Contractor.

Chart of Accounts

Sage 100 Contractor supports an integrated chart of accounts that functions across all modules of the system.

One of the first tasks when creating a new company in Sage 100 Contractor is to set up the general ledger structure. When you select the pre-built chart of accounts, the program automatically sets up the account ranges, controlling account numbers, posting account numbers, and then creates the ledger accounts. You can then modify the ledger setup to meet your particular needs. However, you may need to edit the ledger accounts to match any changes made in 1-8 General Ledger Setup.

You can also set up the general ledger manually. If you choose to enter the account ranges, controlling accounts, and posting accounts manually, the program will not create the ledger accounts. You will then need to create each ledger account in the Ledger Accounts window.

If you are setting up a completely customized chart of accounts, you should work with a business partner.

Department

Departments help organize income and expense data and provide a means to evaluate the profit and loss for a company by functional unit or profit center. A single controlling account uses a set of subsidiary accounts tailored to the controlling account. In contrast, income and expense controlling accounts share the same set of departments, and each controlling account that uses departments has the same set of subsidiary accounts.
Chapter 2: Underlying Concepts

You can use departments in a variety of ways. Some companies have separate divisions, which use the departments to track the individual income and expense for each division. Others use departments to track types of jobs such as residential or commercial, new or remodel, or other combinations. Still other companies use departments to track performance of salespersons or project managers for bonuses. When you operate in multiple states, you can create income statements by state using departments.

**Controlling Account**

A controlling account is a ledger account in the general ledger that summarizes the balances for a group of similar subsidiary accounts.

With specific, dedicated controlling accounts, the program uses the accounts you designate to automatically post certain transactions to the correct ledger accounts. For instance, when you post a receivable invoice, you do not need to supply the accounts receivable ledger account. After posting a transaction to the general ledger, the program locks the account numbers for the accounts under Controlling Accounts. The account numbers are locked and unavailable for editing.

You can change the account numbers on the Receivables, Payables, Equipment, and Inventory tabs regardless whether you have posted transactions. If you change the account number on the Receivables, Payables, or Equipment tabs, you have to move the balances to the new account through a journal transaction.

Controlling accounts are a good way to ensure that your data is properly entered into Sage 100 Contractor.

**Subaccount**

Using subaccounts (subsidiary accounts), you can arrange financial information into related categories under a single ledger account, providing quick access to specific information. A ledger account that uses subsidiary accounts is known as the controlling account. Primarily asset and liability accounts use subsidiary accounts, although you can also use subsidiary accounts with income and expense accounts.

Sage 100 Contractor automatically sets up subsidiary accounts for dedicated accounts, such as accounts receivable, accounts payable, and service receivables using the job, vendor, and client numbers as the subsidiary account numbers. Sage 100 Contractor does not, however, provide access to these subsidiary accounts through the Ledger Accounts window because you can view the subsidiary account balances from the Job, Vendor, and Client windows.

**About year-end processes**

Sage 100 Contractor includes separate year-end processes:

- A process for closing payroll
- A process for advancing the fiscal year
- A process for archiving data in General Ledger

For many companies, the fiscal year end is the same as the calendar year end on December 31, while other companies have a fiscal year end other than December 31. Throughout this guide, we provide steps for both your fiscal year end and your calendar year end.

The fiscal and calendar year end can be a busy time. To keep your ledgers current and accurate, audit your books monthly. Sage recommends performing an additional audit several weeks before your year end to
resolve any errors before beginning transactions for the next fiscal year. However, as of version 19.2, if you are on period 12 of your current fiscal year, you can begin entering transactions for period 1 of the new fiscal year even if you are still resolving auditing errors.

After you enter accounting adjustments, resolve any audit errors, and archive your data, make at least two backup copies of your data for your permanent records.

The time required to complete your year-end processes depends on many factors, such as the size of your company, any audit errors, and any accounting adjustments. If all of the following conditions are true, you may be able to finish your year end in a few hours:

- You have already backed up your data.
- You have been keeping up with accounting period audits.
- You only have repairable period audit errors.

**Company archive**

Over the course of a year, the accounting and payroll databases grow as you enter records. Like a manual accounting system where you might move the previous year’s records to storage boxes or a storage facility, you can move Sage 100 Contractor records to an archive file.

When you archive, it is important that you create a mirror image of your data for tax reporting purposes. This is referred to as your company archive or archive directory. It is a copy of your existing company data up to the point when you create the archive.

The company archive resides on the same drive as the active company. With an archive of the previous accounting year on the same drive as the active company, you can simultaneously post to period 0 in the active company and period 12 in the company archive.

**Accounting Period 0 (Zero)**

When you want to enter the startup balances and invoices for a new company or when you want to adjust the beginning balances for a company, post to period zero. Period zero is not part of the fiscal year; therefore, Sage 100 Contractor does not include transactions posted to period zero in any year-to-date reports.

When you post to the asset or liability accounts in period zero, the program adjusts the beginning balances. If you post to income or expense accounts in period zero, the program adjusts the beginning balance of the Retained Earning ledger account because income and expense accounts do not have beginning balances.

**Changing posting periods**

Use the Change Period window to change the default current posting period for the entire program. The window allows you to change to any posting period within the current fiscal year. You can also choose to set the posting period to period 0 (00-Prior Year).

When you advance to the next posting period or a future posting period, for example from period 1 to period 2 or 2 to 9, the program performs an audit automatically. The audit results are logged in the Audit History window. After the audit has been completed, you click the button to change the period.

To change the posting period, under Period Selection, type a period number or click the arrow button to open the Posting Period window from which you can select a posting period.
Chapter 3: Additional Details

These topics are organized around specific Sage 100 Contractor functions. As you plan implementation of a particular area, these concepts will point you toward key points you need to consider to ensure a successful startup.

General Operational Features

About the Sample Company

Sage 100 Contractor comes with a set of sample data, Sample Company, that enables you to learn how to use Sage 100 Contractor windows and new functions without any risk to your own company data.

Sage 100 Contractor master trainers use Sample Company extensively during Sage 100 Contractor training classes. Sample Company is also used in many on-line and recorded classes.

We highly recommend that you load the Sample Company data during your initial installation. It takes very little space on your hard disk drive, and by viewing and working with this sample data, you will learn how different windows use data when you manage a construction business with Sage 100 Contractor.

Sample Company includes:

- Sample accounts, sample employees, sample takeoffs, and much more.
- Starter lists for many values you will need to set up cost codes, cost types, tasks, client status, client type, employee positions, paygroups, and so on.
- Samples of many Sage 100 Contractor forms that are already filled in, making it easy to understand many concepts.
- Live data to investigate the content of Sage 100 Contractor reports.

Sample user names and passwords

You can log in to the sample company using one of the user names that comes with the sample data, or you can use your usual Sage 100 Contractor credentials, providing your system administrator has added you as a user in the Sample Company.

If your system administrator deployed sample data for the current version, the "sample" users are:

- Bryan - Sample User
- Debra - Sample User
- Ginger - Sample User
- Jenny - Sample User
- Josh - Sample User
- Lynn - Sample User
- Scott - Sample User

If your system administrator migrated the Sample Company from version 19.8, the list of users will be the same as it was in that version. If the user names were not modified in the earlier version, the users names are
the same as those listed here, but without “Sample User” at the end. (For example, rather than “Bryan – Sample User,” the user is simply “Bryan.”)

**Note:** These sample users all use the password **password**.

**Archive Company**

Over the course of a year, the accounting and payroll databases grow as you enter records. Like a manual accounting system where you might move the previous year’s records to storage boxes or a storage facility, you can move Sage 100 Contractor records to an archive file.

When you close your books, it is important that you create a mirror image of your data for tax reporting purposes. This is referred to as your company archive or archive directory. It is a duplicate copy of your existing company data up to the point when you create it.

The company archive resides on the same drive as the active company. With an archive of the previous accounting year on the same drive as the active company, you can simultaneously post to period 0 in the active company and period 12 in the company archive.

You can only make a company archive during the process of closing the books at the year-end. When you archive records for a company, Sage 100 Contractor copies all the data from the active company to a separate file. Sage 100 Contractor then removes the records you have selected from the active company to prepare it for the new fiscal or payroll year.

**Company Information Record**

The company information record of Sage 100 Contractor stores key information about a specific company which you are managing with Sage 100 Contractor.

You keep track of such information as:

- Name
- Address
- Phone and fax numbers
- License and tax IDs
- Direct deposit
- email server setup
- Fax setup

See the Sage 100 Contractor Help for a full list. These are all key items to set up since they may drive other parts of your system.

**Security features of Sage 100 Contractor**

Sage 100 Contractor provides a variety of security features that enable you to restrict access to data in each company. You can:
Create a list of users and passwords for each company. You use this list to restrict access to individual companies.

**Note:** Restricting access to a company also restricts access to its archive.

Create groups of users. You create security groups to organize users by function, such as project managers, payables clerks, or payroll clerks. You can assign each user to up to five security groups.

Assign access rights to groups of users. You control user access to windows through security groups, assigning access rights to each security group.

Restrict access to specific data. Control items within windows, such as text boxes, lists, check boxes, and grid columns. By limiting the information a security group can enter or view in a window, you also restrict access to that same information in queries and reports. For example, you might not want to allow the payroll clerks security group access to salaries and wage rates in the employee files. The payroll clerks will not be able to view salaries and wage rates in the employee files, or while entering timecards, or by running any payroll reports.

Each company in Sage 100 Contractor can use different user names, passwords, security groups, and access rights. You only have to set up security groups and access rights one time for each company. As you add or remove users from the User List, you can simply assign or reassign users to the proper security groups.

**Important!** Many actions in Sage 100 Contractor can be performed only by a company administrator. When setting up security, you must add a password for each company administrator.

**About security groups**

Use the 7-2-1 Security Groups window to set up security groups for your company’s employees.

Security groups let you control users’ ability to open windows as well as perform specific actions within a window. The 7-2-1 Security Groups window contains a grid with numbered rows on the left and eight columns:

- **Group#** (User input is required to save the record.)
- **Group Name** (User input is required to save the record.)
- **Save**
- **Delete**
- **Void**
- **Chg Period**
- **Print Checks**
- **Notes**

When you set up user groups, you type a group number and group name. Then you determine whether or not that group will have rights to Save, Delete, and Void records, as well as to change the accounting period and print checks. You may use the Notes column to add any pertinent information about each group.
While you might create security groups for specific employees, it is a good idea to build each security group for the tasks performed by the employee. This allows you to add or remove employees from security groups rather than having to build new security groups for each new employee.

As the company size increases, the need for additional security groups increases. For example, a large company has an office staff that includes several accounts payable clerks, an accounts receivables clerk, a payroll clerk, a controller, project managers, and estimators. In this company, six different security groups are set up to accommodate the specific needs of the employees engaged in six different task areas.

In addition to creating task-oriented security groups, it is a good idea to create one security group with full access to the entire program. This allows owners or managers to log in with full access, but prevents unauthorized access to program features that only a company administrator can use.

It is important to consider the scope of tasks performed by users as well as the number of users that access Sage 100 Contractor. Before designing security groups, examine which users need access to specific windows in Sage 100 Contractor. After you set up the security groups, you can then set up window and menu-level security.

For example, a small company has three clerks: a general accounting clerk, an accounts payable and accounts receivable clerk, and a payroll clerk. For this company, it is only necessary to create three security groups. The first group, titled Payroll Clerk, only provides access to payroll operations. The second group, titled A/P A/R Clerk, provides access to accounts payable and accounts receivable operations. The third group, titled General Ledger Clerk, provides access to general ledger operations not covered by accounts payable and accounts receivable.

Consider the following before setting up security groups:

- Do you need to create separate security groups for employees who perform specific tasks? For example, does your company have a payables clerk who only enters payables data?
- Do you need to create separate security groups for accounts payable, accounts receivable, and payroll supervisors, or can you just create one group for the supervisors?
- Do estimators perform different tasks than project managers?
- Do you need to provide differing levels of access to owners, controllers, or managers?
- Are you going to use the Sage 100 Contractor API to integrate with other programs? If so, create a security group named API with a group number such as 51.

**Important!** To use the Sage 100 Contractor API program, you must create an API security group that is named exactly API. At least one user must be added to the API security group. You have to set rights to save, void, and so on.

### About company administrators

If you have been set up as an administrator for a company, you have access rights to the entire Sage 100 Contractor application while you are logged into the company.

**Important!** To maintain security, we highly recommend that each company administrator has a strong password. Be sure to write it down and keep it in a safe place.

Following is a list of actions only company administrators can perform:
• Create security groups in **7-2-1 Security Groups**.
• Grant access rights to security groups for windows and items within windows such as text boxes, lists, and grid columns in **7-2-1 Security Groups**.
• Grant job-level security to specific users in **7-2-2 User List**.
• Use the F7 key to display the Field Properties dialog box to set the individual security properties for a text box, list, check box, or grid column, as well as set security for certain menu commands from the main menus. You can also customize the window, set defaults in specific fields, and set system user prompts.
• Create user names and passwords, and assign user names to security groups in **7-3-1 User List**.
• Create new companies in **7-1 Create New Company**.
• Make and save changes to the General Ledger in **1-8 General Ledger Setup**.
• Archive the accounting at the fiscal year-end using **Archive Oldest Fiscal Year** in Database Administration.
• Archive payroll at the calendar year-end using **Archive Payroll Data** in Database Administration.
• Restrict posting to specific accounting posting periods, for example, **4-2 Payable Invoices/Credits** and other windows.

**Field Properties**

Field properties allow a company administrator to extend security wherever it is needed.

The company administrator can assign field properties for every field on every entry window and grid in the program. Items defined include defaults, custom field names, field processing during entry, and which users have access the window and fields on the windows.

**User Name**

You can set up a list of user names for each company to control access to each company you set up in Sage 100 Contractor. By setting up security groups and assigning the groups to user names, you can further limit access to certain windows, and text boxes, lists, and columns within windows.

Because Sage 100 Contractor determines access through the user names, a user can log on to the program from any workstation in a network environment.

**User-defined Fields**

User-defined fields are available on many key forms in Sage 100 Contractor. They offer another way for you to customize Sage 100 Contractor for your business. You can determine the names and how these fields behave and then use them in your own reports.

**Export**

Exporting is a Sage 100 Contractor concept for moving data from one area of the program to another. This provides powerful workflow features to automate key tasks. Export capabilities are found throughout the program but key ones support development of purchase orders, bids, proposals, change orders, subcontracts, and budgets from takeoffs.
Files can be exported as templates to be used in other jobs or in other Sage 100 Contractor managed companies. This saves you valuable time as you copy key components from job to job and also provides consistency for job analysis.

Exporting can also be done from many grids, and creates standard .csv files. You can use Send report data to Excel from almost all reports.

These capabilities will allow you to take your Sage 100 Contractor information and feed other custom applications your company may use.

**Import**

There are many different import capabilities in Sage 100 Contractor. These capabilities allow you to bring data into Sage 100 Contractor from different outside sources. Imports also allow you to use saved files and templates to get a fast start on new jobs.

Basic capabilities for import are provided in virtually every grid via standard cut and paste.

Specialized external imports support such features as price updating from parts databases. Finally, specialized programs from third-party vendors provide complete ways to import a variety of specialized data, from time sheets to estimating data and beyond.

**Defaults**

You can customize many different aspects of Sage 100 Contractor. For instance, by using security groups, you can grant or restrict access to specific windows. Within a window, you can customize text boxes, lists, check boxes, and columns to increase data entry speed and accuracy. Within each window, you can set up default information, require entries, skip entries, or even limit access to specific security groups.

For instance, in the Checks and Bank Charges window, set the default ledger account number for your checking account in the Account Number box. When you open the window, the program automatically inserts the account number.

You can save time and effort by setting up your preferences for report types, form designs, selection criteria, and options in the Report Printing window. You can also set preferences for printers, page ranges, page orientation, and number of copies to print. When you save the defaults, the program assigns them to the person currently logged on to the program by referencing the person’s user name.

You can copy most defaults (except security groups) from existing users to new users to speed setup of new employees.

**Template**

Sage 100 Contractor templates can provide the starting point for just about any business process. A template can include any information you want to provide, such as dates, descriptions, or other important information. You can create a template from scratch, or modify an existing record and save it as a template. Unlike a record, you do not have to complete required fields to create a template. Many windows throughout the program let you create templates.

Suppose that you are building homes in a residential subdivision. The budget and proposal for the base design are established and do not vary. Using templates in the change orders window, you can create a different template for each upgrade. When you are informed which upgrades the home buyer wants, you can quickly load the corresponding templates to create the necessary change orders.
You can either use an existing record as the basis for creating the template, or you can build the template from scratch.

Templates are a key tool for customizing Sage 100 Contractor and also provide ways to standardize data input so you can manage your company. Consult with your business partner to analyze where templates might help you.

**Notes**

Notes are a feature throughout Sage 100 Contractor. You can keep notes with nearly every type of record, which can prove helpful when reviewing data later. You save notes with individual records, as well as with individual rows in a grid. Notes can be reviewed at any time and can be a valuable part of many printed reports. They are the place to put further details and specifications to make sure all parties understand a decision or need.

Notes can be exported from estimates to provide details of specifications that can support all areas of production.

**Grids**

Grids are a powerful feature of nearly all Sage 100 Contractor functions. Essentially, grids display the detail information of a transaction, estimate, budget, change order, or any item which has a header to details relationship.

All users can customize grids to display just the information they need. You can modify and save the grid defaults by user.

Grids also provide a handy way to import and export information from and to external programs with simple cut-and-paste capabilities.

Within Estimating, takeoff grid files provide specialized functionality for rapidly building estimates using a library of already developed grids.

You need to study each grid in the detail screens before you implement that section of Sage 100 Contractor.

**Lookup Windows**

Lookup windows help you locate data. Suppose you are entering a payable invoice, but do not remember the vendor number. You can open a Lookup window, find the vendor, and then insert the vendor number in the appropriate box.

Lookup windows are used throughout Sage 100 Contractor. You can sort items in a lookup window, set a default sort order, and select items with a click.

Learning to use lookup windows is part of the mechanics that will make your Sage 100 Contractor experience successful.

**Quick Lists**

With quick lists, you can create lists of transaction descriptions, names, states, and ZIP Codes, then quickly retrieve the information for entry. Each list is specific to its associated text box and window.
This is a very handy feature for ensuring that your data is consistent. In conjunction with setting Field Properties and locking the quick list, you can guarantee that data will be entered with the values you need.

About file and link Attachments on records

What are attachments?

Attachments provide functionality to attach files and/or Web links to selected records in Sage 100 Contractor. There are two methods for attaching files and links. You can add them individually using the Attachments window (Edit > Attachments), or you can simply drag-and-drop files and/or Web links onto a Sage 100 Contractor window that accepts attachments.

A few examples of Sage 100 Contractor windows that accept attachments are payable invoices, requests for proposal, progress bills, change orders, purchase orders, jobs.

How can I use attachments?

Here are a few examples:

- After receiving a hard copy document that you would like to attach to a payable invoice record in 4-2 Payable Invoices/Credits, you scan the document into your computer to create a file, then attach the file to the payable invoice record.

- You have several digital photos of work being done on by a subcontractor on a remodel job. You can transfer these files to your computer, and then attach them to a record in 6-7-1 Subcontracts.

- After sending an RFP to an architect who has a Web site, you want to attach the architect’s web site URL link to the RFP. From the open the site in your browser, you drag and drop the link from the browser’s Address box onto the 6-11-1 Requests for Proposal record.

How does attachment functionality work?

You create an attachment as either a “local” attachment or a “link” attachment. Link attachments can either be a file or a URL (Web site link).

Creating a “local” attachment, associates the a local file (on your local computer) or a copy of a network file (copied from a network computer) to an Sage 100 Contractor record in your local computer’s company data. In this process, the program creates a local folder and subfolder structure in your local company where the record is located.

Creating a “link” attachment, attaches a link to the remote file (on a network computer) or URL link to Web page on a remote computer. The program does not create a local folder and subfolder structure in your local company for linked attachments.

Important! For link attachments, do not rename an attachment’s file server after attaching a file. Sage 100 Contractor cannot locate a linked file if the file server is renamed or replaced by a server with another name.

Can I drag and drop files to create attachments?

If a record accepts attachments, you can drag and drop files onto the window to create an attachment. This includes graphic files, Web links, email messages, desktop shortcuts, or any other file type.
Note: If you use Microsoft Outlook, you can drag and drop email messages from your Inbox list directly onto a Sage 100 Contractor record.

Where are attachments located?

First, let's look at what happens when you attach a local file to a record. When you add the attachment and save the record, the program creates an Attachments folder and folder structure under `\\[ServerName]\[CompanyName]\Attachments`. To prevent naming conflicts between files, each file in placed into a subfolder with a unique name.

For example, let's suppose you are working in Sample Company job Jiminez Burrito #8, and you attach a local graphic file to record 8 in 6-4-1 Change Order, Floor Tile Upgrade. After saving the record, in Windows Explorer, you will find this path: `\\[ServerName]\Sample Company\Attachments\Jobs\Change Orders\(unique subfolder name)\(file name).gif`.

Tip: Sample Company data can be changed on any computer. The Sample Company data in these examples may not match the Sample Company data on your computer exactly.

What is the attachment parent-child structure?

You probably noted that the Change Order folder is a subfolder of Jobs. That's because the program creates Attachments according to the existing parent-child relationships that already exist in the program for Jobs and Change Orders.

For example, the parent record for the change order is the job, 215-Jiminez Burrito #8. If you were to open, 6-6-1 Purchase Orders to record 38, clear the Lock Edit, and add the same graphic file to this record and then look at the folder structure, you will find `\\[ServerName]\Sample Company\Attachments\Jobs\Purchase Orders\(unique subfolder name)\graphic.gif`. The attachments to the purchase order record and the change order record are both "children" of job 215—Jiminez Burrito #8, which is located in 3-5 Jobs (Accounts Receivable).

What do I see when opening parent record when children have attachments?

You can attach files to both "parent" records and "child" records. For example, you can attach files and links to job 215-Jimenez Burrito #8 directly from that job's record in 3-5 Jobs (Accounts Receivable) or to that job through other records such as Change Orders, Purchase Orders, Subcontracts, and so forth. As described above, you can add attachments to records that are children of the job.

Because of the parent-child structure of the program, when you open the Attachments window from the parent window 3-5 Jobs (Accounts Receivable) 215-Jimenez Burrito #8, you can select different ways to view the Attachment related to this job using the box with the title, Show items attached to:

- **This job directly.** If the parent record has attachments, the attachments would be displayed in this list.

- **Purchase Orders for this job.** If a "child" purchase order record of this job has attachments, then the attachments would be displayed in this list.

- **Change Orders for this job.** If a "child" change order record of this job has attachments, then the attachments would be displayed in this list.
How does attaching network files work?

When you select a network file to attach to a record, the program recognizes that it isn’t a local file and offers two choices, Copy the file to my company data (my local computer), or Link to the existing file (on a network computer).

If you select to Copy the file to my company data, the program makes a copy of it and places it in a folder\subfolder structure under \[ServerName]\[CompanyName]\Attachments\ in its parent-child relationship.

If you select to Link to the existing file, the file remains on the network computer. A copy of it is not created, and it does not appear in a folder under \[ServerName]\[CompanyName]\Attachments\. In fact, if you never link to a local file or copy a attachment file to your computer, you will never see an Attachments folder under the company folder.

What happens if I select “Protect this file from being changed”

After you link to a network file by selecting Copy the file to your company data, you have the option to Protect this file from being changed. After saving the record, if you were to open the linked file and try to edit it, the program that opens it displays a message stating that the file cannot be changed, is read-only, or something similar. The message displayed depends on the program that opens it.

Note: If you select the option, Link to the existing file, the Protect this file from being changed option is unavailable. If you need to prevent an attachment from being changed, select the Copy file to my company data option.

How do I attach Web links?

When adding a link to a Web page as an attachment, you are encouraged to copy and paste the contents of your browser’s Address box (a URL—unique resource locator) into the box on the Add Attachment window. You can type the URL in the box, but it’s much easier to copy and paste it to avoid possible errors from typing mistakes.

Tip: Attachments that are Web links are always remote and never appear in an Attachments folder under \[ServerName]\[CompanyName]\.

How do I know that a record has attachments? Are there visual indicators?

An Attachment button has been added to the toolbar. It displays a paper clip against a grey background if the record has no attachments. It displays a paper clip against a white rectangle if the record has attachments. You can click the Attachments button to open the Attachments window whether the record has attachments or not.

Important! To provide room for the Attachments button, the Count button has been removed from the toolbar. On windows that provide the count files functionality, the Count command is available from the menu bar.
Can I email attachments?

**Important!** Emailing attachment functionality only works if Microsoft Outlook is your default Email client.

Yes, just open an **Attachments** window, and select one or more attachments. Click **Email**, and the program opens an email message with the attachments included in the **Attach...** box.

Can I print Attachments?

Yes, just open an **Attachments** window, and select an attachment. Click Print, and the program opens the file in the program that is controlled by your Windows settings.

**Note:** Printing from the **Attachments** window behaves the same as right-clicking the file in Window Explorer and selecting **Print** from the menu.

Accounting Details

**General Contractor (Accounting)**

General contractors are provided with specific general ledger chart of accounts they can select during set up. They also have a starting set of cost codes that may suit their needs. Functionally, Sage 100 Contractor provides a range of management tools for the general contractor to manage scheduling, purchasing, and subcontractors.

When you select the pre-built chart of accounts, Sage 100 Contractor automatically sets up the account ranges, controlling account numbers, posting account numbers, and then creates the ledger accounts. If you use payroll and use the command to **Create Standard Calculations**, then the payroll calculations are automatically linked to the proper general ledger accounts.

General contractors can also copy and customize the Sample Company **Cost Code List**.

**Home Builder (Accounting)**

Home builder capabilities are built right into Sage 100 Contractor. Industry standard general ledger chart of accounts and cost codes are available when you create new companies. Additional features include “starter” task lists plus some standard parts and assemblies.

Sage 100 Contractor also provides a special selection of project management reports just for home builders. You may also find that the work in progress (WIP) features are useful.

**Work In Progress (Accounting)**

Many contractors refer to any project in the process of completion as a work in progress. You can print a WIP report for any job to determine the WIP adjustment for “percentage-complete” accounting. Using this adjustment, you can post a transaction that allows you to compare the revenue generated during a given fiscal period to the expenses incurred during the same fiscal period.

WIP also refers to a method of accounting used with speculative projects. Because the contractor owns the project, the contractor must declare improvements to the property as an asset. Only after the contractor sells the property, does he or she then declare the revenue and expense.
Methods for using WIP adjustments and WIP for speculative projects are detailed in Sage 100 Contractor in-product Help and in the User Guide. You should review this information with your accountant or business partner before you start using WIP features.

**Remodeler (Accounting)**

Sage 100 Contractor offers specialized support for remodelers in two areas.

- **General Ledger** - When you select the Remodeler Accounts, Sage 100 Contractor automatically sets up the account ranges, controlling account numbers, and posting account numbers, then creates the ledger accounts. You can then modify the ledger setup to meet your particular needs. This accounting structure has been put in place for the needs of remodelers.

- **Estimating Data, Cost Codes, and Tasks** — Sage 100 Contractor provides remodelers with starter data, giving you a head start on setting up your accounting structures.

  Estimating data can be used as a starting point for your takeoffs, saving you time when creating estimates. This includes a specialized chart of accounts, cost codes, tasks and the following estimating data:

  - Parts
  - Assemblies
  - Part/Assembly classes
  - Takeoff grid files

**Subcontractor (Accounting)**

Subcontractors are provided with specific general ledger chart of accounts they can select during set up. They also have a starting set of cost codes that may suit their needs.

Sage 100 Contractor provides functionality needed by the Subcontractor such as management for change orders, capabilities for importing from specialized estimating systems and management of the pre-lien and release process.

**Current Period default (Accounting)**

Sage 100 Contractor sets an accounting period default depending upon your fiscal year-end date and the current posting period date established during your general ledger setup. You then control the movement of your accounting to the next period using the windows under 1-6 Period/Fiscal Year Management.

You can have Sage 100 Contractor verify the date of transactions versus this default. You can also change the default period while you are entering a specific set of transactions.

**Posting period (Accounting)**

Using 1-6 Period/Fiscal Year Management, you can set the posting period to any period from 0 (prior year) to 12. When you advance the posting period, the program performs an audit automatically, and the audit results are logged.

As you enter individual transactions, Sage 100 Contractor will assign them to the current accounting period, but the program can be set to check the transaction date and warn you of an error in posting an item.
Audit (Accounting)

When you audit the books of a company, Sage 100 Contractor verifies that the accounts are balanced and that valid transactions support the balances.

In Sage 100 Contractor, you can audit the books at any time to help maintain your ledger balances. When you audit the books, the program does not make any changes, but it does log any errors using the Audit History function.

When you advance to a new period in the future, the program audits the books automatically as part of the process to change the default posting period.

When you start a new company or suspect data corruption, it is a good idea to audit the books and recalculate balances. If unbalanced data exists, the program alerts you so that you can correct the errors as early as possible.

Fiscal Year (Accounting)

Sage 100 Contractor's fiscal year is driven by the year-end day you select when you complete your general ledger setup. Once you set this date, you do not have to change it annually. Sage 100 Contractor will do so as part of the fiscal year-end archive process.

"Fiscal year-end close (Accounting)" below

Prior Year (Accounting)

The year-end close process creates a prior year company which Sage 100 Contractor calls the archive company.

For ledger accounts, Sage 100 Contractor rolls over the ending balances for permanent accounts to become the beginning balances for the new fiscal year. All period balances roll over becoming balances in the Last Year column. All temporary accounts, such as revenue and expense, start the year with zero balances.

When closing the books, the program only deletes “cleared” prior-year check records and the remaining prior-year checks are appended to the prior-year check database (DBF) file. This allows you to reference prior year checks from more than one previous year.

"Archive Company" on page 20

Fiscal year-end close (Accounting)

At the end of fiscal period 12, you can archive the books for the year. Before archiving, be sure to create a backup of your data. The backup represents a permanent copy of your financial data.

During the close at the fiscal year-end, the program audits the accounting to verify that valid, balanced transactions support the account balances. When no errors are present, the program then removes transactions for the closing year and prepares the balances for the new fiscal year. Sage 100 Contractor can create a copy of all detail transaction data in the archive company.
Calendar Year-End (Accounting)

Calendar year-end can be combined with fiscal year-end for a complete closing of your Sage 100 Contractor general ledger. For calendar year-end, you may wish to just close the payroll and reset vendor 1099 balances. You can then send W-2s and 1099s from your archive company.

Payroll details are best viewed in the Help topic, "About closing the payroll." Vendor 1099 details are best viewed in the Help topic, "About Federal 1099 forms."

"Fiscal year-end close (Accounting)" on the previous page

Journal transaction (Accounting)

Use the journal transactions capability to review most general accounting records. You can also use journal transaction capability to enter adjusting journal entries.

You cannot, however, enter transactions or adjust journal entries for the following:

- Accounts payable
- Accounts receivable
- Service receivables
- Inventory
- Payroll

These accounts are posted by their own subsystems.

Profit (Accounting)

Sage 100 Contractor has a multi-step income statement for developing company profit. Gross profit is developed, and then overhead and administration are deducted for earnings before income tax. Finally, after-tax items are deducted to reach net profit.

Analysis Details

Sample Reports (Analysis)

Sage 100 Contractor provides representative samples of most reports that are available. These samples are not generated from the sample data but are images for you to view. Viewing these provides a sense of the report content without having to learn the specific selection criteria to view valid data.

Take some time to review the reports available to you under each menu item as you start your implementation. For example, under menu item 3-Accounts Receivable, you have 3-1 Receivable Reports.

Over/Under Billing (Analysis)

The Over/Under Billing report is an analysis tool of Sage 100 Contractor to help you keep your jobs profitable. This report combines cost, budget, contract, and billed information into one key summary that highlights jobs where your costs may be running away or where a key billing has not been done. This reporting is also referred to as a WIP report in the construction industry.
Profit (Analysis)

Sage 100 Contractor provides many reports for analyzing job profitability. These reports are found under menu 3-Project Management. You can start at a high level to identify possible problem jobs by comparing budgets to costs line by line. Then you can drill down into the records to determine where the problems are in detail.

Accounts Payable Details

Invoices (Accounts Payable)

In the 4-2 Payable Invoices/Credits window, you can enter transactions that affect vendor accounts. You can create payable invoices or credit invoices, track and release retention, or view a history of payments for a specific invoice.

Another critical tool for managing vendors is the ability to print and post two-party checks. From the 4-2 Payable Invoices/Credits window, you can access the Secondary Payees window to manage such invoices. Secondary payees are most often involved with subcontractor invoices because they have subvendor suppliers who have lien rights to the project. It is critical to ensure that these suppliers get paid. The use of two-party checks provides this assurance.

A number of other features enhance record entry. When you select the Manufacturer Details option, Sage 100 Contractor includes the manufacturer’s name and part number in the description of each part. To help manage inventory, select the Allow Freight/Variance option to post variances in material or freight costs. When you have finished entering records, use the batch list to verify the invoice totals against the actual invoice totals. The Use PO Sales Tax option is enabled automatically. If you enter an invoice using information from a purchase order, the sales tax is calculated automatically.

Some states do not require subcontractors to carry Workers’ Compensation insurance. In these states, the subcontractors use the general contractor’s insurance policy for the duration of the job, and the general contractor deducts the cost of coverage from payments to the subcontractor. Check with your state for compliance requirements as the laws vary in each state. When entering a payable invoice for a subcontractor, you can calculate the cost of coverage and add it to the invoice as a credit.

Use the Remove Paid/Void Invoices option to remove paid or voided invoices that meet the following criteria:

- The status is Paid or Void.
- The invoice does not have a job number.
- Associated payments have been posted prior to the current year.

Vendors (Accounts Payable)

Vendor records provide quick access to vendor information for payable invoices, 1099 balances, ordering materials, and subcontract management. Create a vendor record for each business that sends you invoices and each business to which you owe money or make regular payments. These vendors may include subcontractors, architects, engineers, and lenders.

In the 4-4 Vendors (Accounts Payable) window, you can review vendor-related information such as subcontracts, purchase orders, invoices, and payments. You can also record any additional certificates a vendor is required to supply.
You would select the **Internal Vendor** check box to keep track someone you need in the vendor database, but not someone from whom you get invoices. Flagging a vendor as “internal” causes the program to display a message if you try to enter a payable invoice for that vendor.

Examples of internal vendors are architects, engineers, or other professionals who are involved with projects that you work on, but you are not the one contracting with them because you are not the general contractor or owner. You might, however, want to keep that information in the job record.

Internal vendors may also be fictitious entities, such as a generic lumber supply or generic tile subcontractor. You might want to use that entity for putting a “type” of vendor on parts for estimating and bid request reasons.

**Vendor types (Accounts Payable)**

You can use vendor types to group or categorize vendors. Types give you the ability to select specific vendors when printing bid requests, vendor lists, or other vendor related documents.

If you create a long list of vendor types, you can simplify it by abbreviating vendor categories. For example, use **M** for material suppliers and **S** for subcontractors in the **Type Name**. For example, the description for a lumber supplier is **M-Lumber**, and an electrical supplier is **S-Electrical**.

**Retention (Accounts Payable)**

Many job subcontracts include retention. When you create a payable invoice, Sage 100 Contractor withholds retention at the rate specified in the subcontract record. If you do not indicate a retention rate in the subcontract record, you can withhold a flat amount on each individual invoice.

Posting a payable invoice declares the entire amount of the invoice as an expense. However, a percentage of the gross amount is withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net invoice amount). Therefore, retention is already declared as an expense but is not paid out yet. Consequently, Sage 100 Contractor does not include retention in the invoice aging.

When you are ready to pay the subcontractor for retention, it is not necessary to create a new invoice. You can release retention on each invoice individually, or you can release the retention for the entire subcontract at one time.

**Accounts Receivable Details**

**Client (Accounts Receivable)**

Use the **3-6 Receivable Clients** window to store information about past, current, and future clients as well as manage the sales process and track client related issues. To help manage sales, you can keep track of referrals, appointments, and call back dates. You can even keep track of when you last mailed a brochure to a client. In addition, you can set up customized lists to provide information about the lead source, region, company size, and to which mailing list they have been assigned.

You can also set a client record “Inactive” to ensure that no further entries are processed for the client.

Using information from the client database, you can create all kinds of client-related documents and reports. For example, the **Greeting** text box, in which you can enter a personalized greeting such as the owner’s nickname, provides a way to personalize documents. When creating the form design, you can insert a field
representing the information in the Greeting text box. Then when you print the document, Sage 100 Contractor replaces the field with the information from the Greeting text box.

**Client Status (Accounts Receivable)**

The Client Status field is completely customizable for your specific needs. Using client status provides you with information such as sales cycles, credit limits, or other client characteristics. You can even set up the status criteria to separate the clients into client prospects, current clients, and past clients.

**Client type (Accounts Receivable)**

Client types allow you to categorize clients. A subdivision developer, for example, can use client types to list the subdivisions, or the release of homes in subdivisions or to track the interests of prospective home buyers. For some companies such as service/repair contractors, the geographic area is more important because all the clients are homeowners or commercial businesses.

**Job Number (Accounts Receivable)**

Job number is a key for locating job cost records, selecting invoices for payment, and finding a variety of reports. If your job numbering system is set up to reflect specific job groupings, you can use the numbering system for selecting jobs.

When you are setting up a job numbering system, it is important to create one that fits your company’s work. Companies that only do a few jobs a year may not need job numbers with four or five digits, whereas larger companies might need more digits.

**Job Type (Accounts Receivable)**

You can classify jobs that your company performs in any fashion that you choose. You may identify jobs by contract, work performed, or any other means.

Once you have identified the jobs, you can create reports to see the performance of different job types. This may be an alternative to creating artificial departments to do the same thing.

**Contracts (Accounts Receivable)**

Contracts are an essential part of jobs and accounts receivable. Sage 100 Contractor can use your contract terms, dates and amounts to automate many types of billing and follow-up activities.

Contract summary data for a job can show you:

- Original contract amount
- Changes to date
- New contract amount
- Invoiced to date
- Balance on contract
- Open charges
• Balance with tax
• Retained balance
• Net due with tax

These amounts can drive invoicing and will help you analyze and control your jobs.

**Contract Amount (Accounts Receivable)**

The current contract amount is available on the 3-5 Jobs (Accounts Receivable) window. You can find a further breakdown of this amount on the Contract Summary window. This amount is the starting point for some of your billing methods, such as progress billing.

**Invoices (Accounts Receivable)**

The 3-2 Receivable Invoices/Credits window lets you enter transactions that affect receivable accounts. You can create invoices or credit invoices, track retention, or view a history of payments for a specific invoice.

You can also create a simple invoice based on the percentage of work completed for the contract. This type of billing is suitable for subcontractors or small projects.

The Receivable Invoices window also provides the ability to enter taxable and non-taxable items on an invoice at the same time. When you enter a tax district number in the Tax District text box, you can select the items to tax in the Taxable column. If you leave the Tax District text box blank, Sage 100 Contractor assumes each item is non-taxable.

**About receivable invoice status**

The status of a receivable record indicates its location in the process.

---

**Important!** You can change the status of records assigned status 1-Open, 2-Review, or 3-Dispute to another of the first three status settings. However, you cannot assign status 4-Paid or 5-Void.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Open</td>
<td>Indicates a record posted to the general ledger.</td>
</tr>
<tr>
<td>2-Review</td>
<td>Indicates the management or bookkeeping staff should review the record.</td>
</tr>
<tr>
<td>3-Dispute</td>
<td>Indicates a record disputed by the client.</td>
</tr>
<tr>
<td>4-Paid</td>
<td>Indicates a record paid in full.</td>
</tr>
<tr>
<td>5-Void</td>
<td>Indicates a voided record.</td>
</tr>
</tbody>
</table>

**Note:** When an invoice or credit is fully paid, Sage 100 Contractor automatically assigns status 4-Paid. If you void the record, Sage 100 Contractor automatically assigns status 5-Void.
About receivable invoice types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Contract</td>
<td>Use type 1-Contract when the invoice affects the billing for the contract. A receivable invoice assigned type 1-Contract increases the job balance, and a credit invoice with this type reduces the job balance.</td>
</tr>
<tr>
<td>2-Memo</td>
<td>Use type 2-Memo when the invoice does not affect the job billing for the contract. For example, when you enter a job deposit as a credit invoice, assign it 2-Memo so that the credit does not affect the invoiced to date amount. You can also use this type with bad debts. Entering a credit invoice assigned 2-Memo does not reduce the invoiced to date amount, but clears the debt.</td>
</tr>
</tbody>
</table>

Entering receivable invoices

You can review the record totals before saving the invoice or credit. On the Options menu, click Calculate.

You can provide part numbers on an invoice. Sage 100 Contractor only includes the parts on the invoice, and does not use the part information elsewhere.

When you enter a tax district number in the Tax District text box, you can select which items to tax. In the Taxable column, type Yes if the item is taxable, or No if the item is non-taxable.

To enter a receivable invoice

1. Open 3-2 Receivable Invoices/Credits.
2. Do the following:
   a) In the Invoice# text box, enter the invoice number.
   b) In the Date text box, enter the date of the invoice.
   c) In the Job text box, enter the job number.
   d) If the job uses phases, enter the phase number in the Phase text box.
   e) In the Description text box, enter a brief statement about the invoice.
   f) In the Due Date text box, enter the invoice due date.
   g) In the Discount Date text box, enter the due date by which you must receive payment for the client to receive the discount.
   h) In the Status list, click the invoice status.
   i) In the Type list, click the invoice type. The contract affects the invoiced balance when Type 1-Contract is selected. Type 2-Memo does not affect the invoiced balance.
Chapter 3: Additional Details

3 In the grid, do the following:
   a In the **Description** cell, enter a brief statement about the item.
   b In the **Quantity** cell, enter the quantity of items.
   c In the **Price** cell, enter the price for a single item.
   d In the **Account** cell, enter the ledger account number.

4 Repeat step 3 for each item.

5 In the **Discount** text box, enter the discount for early payment.

6 On the **File** menu, click **Save**.

7 In the **Retention** text box, enter the amount of retention.

**Voiding receivable invoices**

If you discover an invoice was entered incorrectly, determine the best method to correct the error. For example, if the error is in the header information, you can edit the information contained in any of the text boxes, except in the **Job** and **Tax District** text boxes, and re-save the record.

When the invoice contains an incorrect job number, tax district, ledger account, or amount, void the invoice and then re-enter it with the correct information. By voiding and re-entering the invoice, you create a clear audit trail.

There are also circumstances when you cannot void the original record. For example, you cannot void a credit invoice that has been applied in full, or an invoice posted to period 0. Because you cannot void these types of transactions, it is necessary to enter an adjusting invoice.

Before voiding an invoice, reverse all the payments posted to it. You can then enter the invoice correctly and reapply the payments.

You can void a receivable invoice with an assigned status of **1-Open**, **2-Review**, or **3-Dispute**.

When voiding an invoice that contains discretionary taxes, Sage 100 Contractor also voids the tax amount. If the voided invoice reduces the discretionary taxes below the billing maximum, Sage 100 Contractor continues to calculate the discretionary taxes until the tax maximum is met.

**To void a receivable invoice**

1 Open **3-2 Receivable Invoices/Credits**.

2 Using the data control, select the record.

3 If an amount appears in the **Paid** text box, reverse the payments.

4 On the **Edit** menu, click **Void Invoice**.

**Creating invoices based on contract balances**

You can create a receivable invoice for a job based on the amount of work completed. Using the original contract amount or the new contract amount and the amount you have invoiced to date, Sage 100 Contractor determines the balance remaining on the contract.

When you supply the percentage of the contract that is completed, Sage 100 Contractor computes the amount to bill. This method is similar to progress billing, but does not provide a detailed breakdown by cost.
code of the progress. Instead, the invoice contains a single line describing the percentage of work completed and the invoice amount. This method of billing is best suited for subcontractors.

**To create an invoice based on the contract balance**

1. Open **3-2 Receivable Invoices/Credits**.
2. Enter the invoice.
3. On the **Options** menu, click **Contract Summary**.
4. Choose the type of invoice you want to create by selecting the **Percentage of Contract** or **Percentage of New Contract** option.
5. In the **Percent Complete** text box, enter the total amount of the contract that is completed.
6. The **Amount to Bill** text box displays the computed amount. You can edit both figures if necessary.
7. Click **OK**.

**Note:** Sage 100 Contractor automatically increments the new contract amount as change orders are approved. The amount billed does not change, but the percent billed changes since it is determined from the new contract amount.

**About receivable credits**

**Important!** You cannot reverse a credit invoice after applying it to an invoice. If you apply a credit invoice to the wrong invoice, make adjusting invoice entries to correct the error.

Many situations could cause you to enter a credit invoice. Suppose a client provides a prepayment on a job, or overpays an invoice. In either case, it is necessary to reduce the accounts receivable.

When you save a credit invoice, Sage 100 Contractor reduces the job balance. However, the credit invoice retains status **1-Open** until you apply it against other invoices in the **3-3-1 Cash Receipts** window. After you have applied the credit balance to other invoices, Sage 100 Contractor assigns the credit invoice status **4-Paid**.

You can also apply a credit invoice to an invoice at the time you save the record. If the invoice is fully paid by means of the credit invoice, Sage 100 Contractor changes the status of the invoice to **4-Paid**. If the invoice still has a balance after applying the credit, the invoice status is not changed. Likewise, if the entire amount of the credit is applied, the status of the credit invoice changes to **4-Paid**. If a credit invoice still has a balance after applying it to an invoice, the status of the credit invoice remains unchanged. You can then apply the remaining credit invoice balance to other invoices in the **3-3-1 Cash Receipts** window.

**Recalculating invoices or credits**

After making changes, you can recalculate the new totals.

To calculate the balances, on the **Options** menu, click **Calculate**.

**Statement (Accounts Receivable)**

A statement summarizes the activity of invoices, payments, credit invoices, and retention for a job. It is a good idea to print the statements at the end of each month and send them to your clients to keep clients
informed of the financial activity for their job.

Sage 100 Contractor supports monthly statements with finance charges and also combined and summary statements.

**Retention (Accounts Receivable)**

Many job contracts include retention. When you create a receivable invoice, Sage 100 Contractor withholds retention at the rate specified in the job file. If you do not set up a default rate in the job file, you can withhold a flat amount on each individual invoice.

Posting an invoice declares the gross amount of the invoice as income. However, a percentage of the gross amount is withheld as retention, so the client is actually billed for the net amount (gross invoice amount – retention = net invoice amount). Therefore, retention is already declared as income but is not yet due. Consequently, Sage 100 Contractor does not include retention in the invoice aging, and does not apply finance charges to it.

When you are ready to bill the client for retention, it is not necessary to create a new invoice. The retention has already been declared income, so you only need to release the retention that has been withheld. You can release retention on each invoice individually, or you can release the retention for the entire job at one time. Having released the retention, you can then send the client a statement reflecting the amount that is due your company.

**Progress Billing (Accounts Receivable)**

The 3-7 Progress Billing window provides a system for creating progress billings, with each new application building on the previous submitted application for a job. Then under each job, Sage 100 Contractor assigns each application its own application number. Most progress bills are printed on AIA certificates.

Creating a progress bill requires that you provide some basic information in the Progress Billing Setup window. You can provide the name of the architect and the architect’s job number for the project, as well as the income posting account, tax district number, retention rates, and a maximum for retention.

To create an application, import the cost codes or divisions from the job’s budget or proposal. You can then select several ways to automatically update the cost information from the job cost records. When you select the Percent from Costs option, Sage 100 Contractor displays the actual job costs and calculates the percent of work completed by comparing the job costs against the budget. You can instead select either the From Cost Amounts or From Billing Amounts option to display only the amounts for each cost code.

When you create an application, Sage 100 Contractor assigns it status 1-Open. After you have submitted the application, submit the record in Sage 100 Contractor by clicking the Submit button. Sage 100 Contractor then changes the application’s status to 2-Submitted. When the billing is approved, post the billing by clicking the Post button. Sage 100 Contractor creates an invoice, posts it to the general ledger, and then changes the application’s status to 3-Posted. When you want to create the next application, click the Next button. Sage 100 Contractor assigns the posted application status 4-Closed, moves the costs from the Current Quantity column to the Previous Quantity column, and advances the number in the Application# text box.

You can also update the costs of the change work to the progress bill. You can either incorporate the changes to the costs in the cost codes or divisions, or include the total amount of the change order as a separate line item.
Time and Materials (T&M) Billing (Accounts Receivable)

You can bill clients on a cost-plus basis, which is the cost for time and materials plus overhead and profit. Sage 100 Contractor uses the job cost records as the basis for the billing amounts on the time and materials (T&M) invoices.

When setting up a job for T&M billing, you can:

- Assign separate overhead and profit markup rates to each cost type.
- Assign a shown markup rate to each cost type.
- Assign a hidden markup rate to each cost type. When you calculate T&M invoices, Sage 100 Contractor adds the hidden markup to the job cost. The other markups shown, overhead and profit, are computed on top of the new billing amount. The hidden markup does not appear on the T&M invoice.
- Assign wage rate and equipment rate tables to the job. You can use the tables in place of using labor and equipment costs plus hidden markup. In addition, you can set a minimum daily charge, which is the minimum number of hours per laborer, or you can set the minimum units per piece of equipment to charge.

Suppose you own a backhoe and determine it is necessary to charge a minimum of three hours to recover the costs of ownership, maintenance, and mobilization. At a job site, you only use the backhoe for one hour. When you allocate the equipment use, Sage 100 Contractor bills the client for three hours instead of one.

Consider the following additional points:

- If equipment records contain rental billing rates, Sage 100 Contractor creates the job cost with the rental billing rate in the Billing Amount text box and with the Override check box selected. The program uses this amount when calculating the T&M Invoices even if an Equipment Rate table is selected for the T&M job.
- If you want to use the T & M Equipment Rate table you must either: (1) clear the Override check box on the job cost record and exclude billing rates from the equipment record before the job cost records are created; or (2) enter the job cost record directly into 6-3 Job Cost record.
- If equipment records do not contain billing rates when you calculate the T & M invoices, Sage 100 Contractor replaces the billing amount with the rate from the Equipment Rate table. If an Equipment Rate table is not assigned to the T&M job, Sage 100 Contractor replaces the billing amount with the cost plus hidden markup.

Unitary Billing (Accounts Receivable)

With certain types of work, it is more difficult to estimate the amount of work necessary to complete the job. For example, with grading or excavation work it proves easier for a contractor to bill for the number of units of earth moved. The Unitary Billing window provides a system for creating a series of unit-based applications, with each new application building on the previous application for a job.

Creating a unitary bill requires that you provide some basic information in the Unitary Billing Setup window. You can provide the name of the architect and the architect’s job number for the project, as well as the income posting account, tax district number, and the retention rate.

To create an application, import the bid items from the job’s unitary proposal. You can then enter the number of units of work completed. If change orders are issued, you can also enter the units of change. When you
calculate the application, Sage 100 Contractor determines the billing amount based on the units of change and the units of work completed.

When you create an application, Sage 100 Contractor assigns it status 1-Open. After you have submitted the application, submit the record in Sage 100 Contractor by clicking the Submit button. Sage 100 Contractor then changes the application’s status to 2-Submitted. When the billing is approved, post the billing by clicking the Post button. Sage 100 Contractor creates an invoice, posts it to the general ledger, and then changes the application’s status to 3-Posted. When you want to create the next application, click the Next button. Sage 100 Contractor assigns the posted application status 4-Closed, moves the costs from the Current Quantity column to the Previous Quantity column, and advances the number in the Application# text box.

Application (Accounts Receivable)

Applications are generally the starting point for getting approved payments for a number of different processes. You will create an application for payment, get it approved and then submit an invoice.

Applications apply to:

- Progress billing
- Loan draws
- Unitary billing

Tax Districts and Tax Entities (Accounts Receivable)

Most states and many cities impose taxes on sales. The seller must add the tax to the selling price and then pay the taxes to the government. In the construction trades, contractors are usually not responsible for collecting taxes. However, certain types of work require contractors to collect and remit sales taxes to the appropriate government agency. The Tax Districts window provides the flexibility necessary to manage, compute, and report the individual sales taxes levied by state, county, and municipal governments.

When you create an invoice, Sage 100 Contractor determines the sales taxes from the indicated tax district. A tax district is comprised of a group of tax entities to which you report the taxes collected within that particular region. Before you can create a tax district, you must create the tax entities.

After you have set up the various tax entities, you can build different tax districts from them. For a given tax district you can include five tax entities, indicate which cost types are taxable, and indicate whether profit is taxable. To calculate taxes, Sage 100 Contractor separately computes the tax for each entity contained in the tax district, but on the invoice provides a total of the taxes.

Suppose a contractor works in a given state. In the state the sales tax rate is 7.25 percent, and in addition, a given county has a 0.25 percent sales tax rate. Before creating a tax district, the tax entities, titled (State) and (Name) County, are set up, each with its specified rate. The contractor then creates tax district 1-(Name) County, CA, which contains the tax entities (State) and (Name) County. When setting up job records for projects in the county, the contractor can include the tax district. Later when entering invoices, Sage 100 Contractor automatically uses tax district 1-(Name) County, CA and computes the appropriate state and county taxes.

You can also set up tax entities to compute discretionary surtaxes. When calculating the taxes for a job, both the sales tax and the discretionary surtax apply until the total of the taxable items on the billing invoice(s) equal or exceed the maximum. At that time, the discretionary surtax no longer applies, and only the sales tax continues to apply.
Sales tax requirements differ from region to region. In one region you might not have to report any sales tax, while in another region you might need to report taxes on everything but subcontract work. Before setting up the tax districts, consult the local tax agencies to determine the correct tax rates.

**Document Control Details**

**Daily Field Report (Document Control)**

*Note:* This functionality is available only if you have the [Document Control Module](#).

You can track the conditions and events that occur at the job site on a daily basis. You can keep track of the employees and subcontractors working on the job, what equipment was used, and how many units of work were completed. In addition, you can track incidents, meetings, and field orders.

**Submittal (Document Control)**

*Note:* This functionality is available only if you have the [Document Control Module](#).

You can provide submittal documents with all material samples supplied to the general contractor, client, vendor, or architect. The submittal lists each sample you are providing for review. Look for menu command 6-11-4 Submittals.

There is a business advantage to adding information about clients or vendors. When you enter such information on a submittal, the document is legally traceable.

The entry in the **Client** box and **Vendor** box on the 6-11-4 Submittals window are mutually exclusive. On a new submittal record, when you enter a client, the vendor entry is cleared and the client address and contact name are automatically placed into the **Attention** box and **Address** boxes. Also on a new record, when you enter a vendor, the client information is cleared and replaced with the vendor information.

**Equipment Management Details**

**Equipment Cost Recovery (Equipment)**

You can remove the guesswork associated with recovering equipment costs. In the 8-Equipment Management, you can provide the cost to own and operate the equipment for a resource consumption period as well as the estimated use for the resource consumption period. You can then compute an estimated per-unit rate to apply to jobs.

Through the cost recovery rate, you post the costs for owning and operating equipment to the job. The accounting transaction posts a debit to the job expenses account in the direct expense range, and a credit to the equipment revenue contract account in the equipment/shop expense range. The transaction increases direct expenses and reduces equipment expenses, resulting in a more realistic view of job profits. At the same time, the program creates a job cost record and an equipment revenue record.

To determine the cost recovery rate, project the use and costs that you can expect based on records from previous years. Do not include the cost of labor in the operational costs because job costs created in Sage 100 Contractor include the equipment operator's time. It is a good idea to review the cost recovery rate every
year and make adjustments. If you discover that the equipment use is considerably higher or lower than expected, you can make the suitable adjustments.

**Shop (Equipment)**

Sage 100 Contractor handles tracking your equipment and assigning the cost of use to jobs where possible.

When you post transactions to the “equipment/shop expense” range of accounts, Sage 100 Contractor displays the *Journal Transaction Equipment Cost* window regarding cost distribution. In the *Equipment Cost* window, you can break apart costs to create individual line entries that reference equipment, cost codes, and cost types.

Sage 100 Contractor helps you move expenses from the indirect category of *Shop* to direct job-related expenses.

**Estimating Details**

**Assembly (Estimating)**

Assembly estimating is a simple, accurate way to create takeoffs. It also streamlines the management of material costs, quotes, and ordering because each assembly includes all the necessary parts and labor to complete a unit of work.

For example, an interior door assembly might include the door, frame, hinges, trim, doorknob, shims, and nails, and the quantity of each part necessary to complete the work. When creating a takeoff, you can insert the interior door assembly instead of each of the individual parts needed. You only need to then enter the quantity of interior door assemblies needed in the project. When you compute the takeoff, Sage 100 Contractor determines the total number of parts needed to complete the door assemblies.

Assembly estimating is more precise and useful than unit price estimating, which only provides a flat rate per unit of measurement. Suppose you are estimating costs to frame a house, and the cost of nails has increased recently. Unit price estimating makes it difficult to calculate the new cost per unit reflecting the additional costs. You can only add an amount to the takeoff that you hope compensates for the increased cost of nails.

Assembly estimating makes it easier to keep costs up to date. When you update the parts database or a portion thereof, Sage 100 Contractor also updates the part costs in the assemblies, ensuring that you will use the most current costs when you create a takeoff.

To increase the accuracy of your takeoffs, you can create part records for labor costs. As you build the assemblies, include the appropriate labor parts. In some instances, you might need to add several different part records for labor to account for the different types of work required. An assembly for installing a sink, for example, might include labor for setting the cabinet, roughing in the plumbing, installing wiring for a disposer unit, and setting the sink and finishing the plumbing.

Assembly estimating has many benefits:

- Each assembly contains all the necessary parts. It becomes impossible to forget parts that are used infrequently.
- You can generate complete parts lists from the takeoff, which lets you obtain materials quotes before submitting the final bid.
- You can adjust prices according to difficulty factors or site-specific conditions.
- Creation of purchase orders directly from the takeoff, eliminating errors often encountered in unit price takeoffs or separate materials billing processes.
- The accuracy of takeoffs increases as you refine the assemblies.
- You can build a library of modified assemblies.

Parts (Estimating)

A part is a record of an item that you want to track in the parts database. You can manage costs, track part inventories, and even assign an image to individual part records. You do not have to limit part records to building materials; you can even create part records for labor costs. To set up a parts database, enter the parts manually or import an existing database.

If you subscribe to a part-pricing service, you can update the prices in the parts database as you receive the latest service updates.

Parts are used in estimating, service, and inventory. Parts can be used within assemblies for "assembly-based estimating."

Bid Item (Estimating)

Bid items are a way of breaking apart estimates into different categories. A client or lender might require you to submit a proposal based on bid items. Some contractors even use bid items internally as another way to track project data. The bid item categories can differ from job to job and are not necessarily determined by types of work performed. Once the list of bid items is set up for a job, you can use the bid items when creating the project's estimate, budget, and proposal. In addition, you can create unitary bills by bid item; however, you cannot job cost by bid item.

Although primarily available through the Estimating add-on module, bid items can also be used with proposals generated in window under 6-Project Management.

Profit (Estimating)

Sage 100 Contractor provides methods for you to manage the profitability of individual jobs. You can set overhead and profit rates by bid item, cost type, or individual grid cell in a takeoff.

To use this capability, you must have the Estimating add-on module.

Markup (Estimating)

Sage 100 Contractor can apply different markup rates to material, labor, equipment, subcontracts, and five other classes of cost types that you choose. Markups can be applied to specific items and to an overall bid. Markup is applied after overhead.

To use markups, you will need the Estimating add-on module or the Service Receivables/Inventory add-on module.
Inventory Details

FIFO (Inventory)

Note: This functionality is available only if you have the Inventory Add-On Module.

The first-in first-out (FIFO) method assumes that when items are removed from inventory, the inventory account is reduced by the cost of the first item acquired in inventory. This method more closely mirrors the actual physical inventory process. Assuming that the costs to acquire inventory are subject to inflation, a FIFO cost flow assumption results in lower cost of goods sold, higher net income, and thus a higher tax liability.

LIFO (Inventory)

Note: This functionality is available only if you have the Inventory Add-On Module.

The last-in first-out (LIFO) valuation method assumes that when items are removed from inventory, the inventory account is reduced by the cost of the most recently acquired item existing in inventory. Assuming that the costs to acquire inventory are subject to inflation, a LIFO cost flow assumption results in higher cost of goods sold, lower net income, and thus a lower tax liability.

Weighted Average Cost (Inventory)

Note: This functionality is available only if you have the Inventory Add-On Module.

The weighted average cost (WAC) method assumes that when items are removed from inventory, the general ledger inventory account is reduced by the average cost of all items existing in inventory. This generates an average cost of goods sold, net income, and an average tax liability of the specific part being removed.

Inventory Allocation (Inventory)

Inventory moves into the inventory control system through payable invoices, service receivables credits, or purchase order receipts. Once in the system, you use 12-2 Inventory Allocation to post to job costs, to track movement among locations, and to place stock on hold. You can also post transactions to the general ledger for the consumption of stock items by your company, the loss or shrinkage of stock items, and the revaluation of stock.

To use 12-2 Inventory Allocation, you will need the Service Receivables/Inventory add-on module.

Payroll Details

About 5-2-1 Employees (Payroll)

Using the 5-2-1 Employees window, you create an employee record for each employee who works during the calendar year. The record stores personal and work-related information, and acts as the source for each
employee’s hourly pay rates, salary rates, or paygroups. In addition, you can accrue sick and vacation time, provide direct deposit for employees, and automatically recover payroll advances.

**Note:** You require access to 5-2-2 Payroll Records to view earnings and payroll in this window.

On the Compensation tab, you can enter information about Paygroups, Standard Regular Rate, Commission%, Salary, Accrued Sick, Accrual Rate, and more. Under Mark on W-2, you can select the check boxes Retirement Plan and Third-Party Sick Pay to include the appropriate values when preparing the W-2 electronic file.

If you are required to report an employee’s pay classification on their pay statement (as in Oregon), you use the Pay Classification box on the Compensation tab to select the classification.

If you are required by legislation, such as California’s Paid Sick Leave Act, to accrue and report on sick leave entitlements, you also enter the maximum amount of paid sick leave an employee can accrue on the Compensation tab. Sage 100 Contractor uses this amount when computing payroll to determine whether sick leave must be accrued for a pay period. At the beginning of a new payroll year, Sage 100 Contractor brings forward any remaining accrued sick time from the previous year and displays the amount in the Last Year Carry Forward box. This amount is reported on the Sick Leave Verification Report as the accrued sick balance from the previous year. You can change this amount, if necessary.

On the Direct Deposit tab, you enter employees’ direct deposit information and email address for the direct deposit pay stub.

On the Calculations tab, you can select which payroll calculations to use and customize the calculation rates for each employee. Each employee record stores its own calculation rates; you can create one payroll calculation but set up different calculation rates for each employee. When you trial-compute or final-compute payroll, Sage 100 Contractor uses calculation rates from the employee records to compute the deductions and benefits for each employee.

On the Additional Contacts tab, you can add multiple additional contacts for each employee.

**Important!** Contacts entered in employee records are not synchronized with Outlook due to security reasons.

You can also create generic employee records for scheduling resources. A single, generic employee can represent an entire crew, such as a framing crew. Use the generic employee to assign employee resources to tasks in a schedule, thereby preventing the over-allocation of labor. For service work, you can use the generic employee as a placeholder for scheduling work orders in the 11-3 Dispatch Board window.

On the ACA tab, you enter health coverage information for each employee for each month of the year so that you can track hours required for reporting under the Affordable Care Act (ACA). If you offer employees health coverage under a self-ensured plan, you also enter information about their spouse, and their dependents on this tab.

**Note:** You can enter information on this tab only if the system date is January 1, 2015, or later.
**Important!** Do not enter more than one employee record for any one employee. For example, if you make a mistake on an employee record, do not correct the mistake by making a second record for that employee.

**About employee positions (Payroll)**

Employee positions determine how you post payroll costs to the general ledger. Create employee positions that represent the type of work performed by employees such as office workers, job supervisors, and laborers. The list does not need to be complex. However, you must create at least one employee position.

After creating the employee positions, assign them to employee records. When you post a payroll record, Sage 100 Contractor looks at the position in an employee’s record, and the ledger accounts in the employee positions table:

- When a timecard line contains a job number, payroll posts to the ledger account in the **Job Wages** cell.
- When a timecard line contains an equipment number (for maintenance or repair), payroll posts to the ledger account in the **Equipment Wages** cell.
- When a payroll record does not contain timecard lines, or a timecard line does not contain a job number or equipment number, Sage 100 Contractor posts to the ledger account in the **Other Wages** cell.

You can also add a department to each position. When you post a payroll record, Sage 100 Contractor first looks to the job record for a department number. If Sage 100 Contractor does not find a department number in the job record, it next looks to the cost code. If the cost code does not contain a department number, Sage 100 Contractor then looks to the employee position.

**About paygroups (Payroll)**

Use paygroups to manage wages and the benefit packages for union shops, or open shops working Davis-Bacon projects. You can include the paygroups in the employee record or in the job record to provide the correct paygroup when entering timecards. The paygroup then becomes the source for wages and benefits on the timecard lines.

- For union shops, set up a paygroup for each combination of pay scale and benefits package that you need to report. Then assign the appropriate paygroup to each employee record. During timecard entry, Sage 100 Contractor assigns the paygroup from the employee record to each timecard line.

  When working with multiple unions, it is a good idea to provide the union number at the beginning of the paygroup description. Place the important information at the beginning of the description. For example, **80% Apprentice** instead of **Apprentice—80%**.

- In open shops, the requirements between the prevailing-wage projects can vary, and employees can work under a variety of pay categories. For each prevailing-wage project, set up the appropriate paygroups for each combination of pay scale and benefits package that you need to report. Then in the job record, you can list only the paygroups for that job. When you enter a job number on a timecard line, Sage 100 Contractor looks for a list of paygroups. If the job record contains a list of paygroups, it then uses the employee’s position to determine the appropriate paygroup and inserts it on the timecard line.
When creating the paygroups, organize the paygroups by job or geographic area. When numbering the paygroups, skip a few numbers between groups in case you need to add other paygroups later. You may also want to include a job or area description in the paygroup name. This allows quick identification of the correct paygroup when entering timecards.

Each union or prevailing-wage project has specific requirements as to how the benefits are calculated. To manage the different benefit packages, you can assign an independent set of payroll calculations to each paygroup. It is important to review each benefit you provide and determine if it meets the requirements set forth by the governing agency. If not, you will need to create a new payroll calculation.

**About setting up payroll calculations for paygroup benefit packages (Payroll)**

Use the 5-3-4 Paygroups window to assign each paygroup its own set of payroll calculations that Sage 100 Contractor uses to compute its associated benefits. First you select the payroll calculations, and then you assign each a rate. When you perform the final compute of the payroll, 5-3-4 Paygroups is the source for the benefit rates.

In some cases, the calculation methods or the taxes to which a calculation is subject differ from union to union or from job to job. When the calculation method or taxes differ for a similar payroll calculation, you have to set up a separate payroll calculation.

For each paygroup benefit, create a separate payroll calculation in 5-3-1 Payroll Calculations in the Calc Method drop-down list, using the following guidelines:

- You can use most calculation methods for paygroups with the following exceptions:
  - 2-%Total Taxable Wages
  - 10-Per Day
  - 11-Per Pay Period,
  - 17-Tables
  - 18-Variable (manual calc)
  Benefits set up using these methods are excluded from reports.
- Some payroll calculations are computed after a paygroup benefit has been computed and its result has been added to the gross wages. In the Calc Method list, click 3-%Gross + Paygroup Benefits. For example, you might need to compute union dues after the vacation benefit has been added to the gross wage.
- Calculation method 3-%Gross + Paygroup Benefits requires the calculation to have a calculation number larger than that of the calculation that adds the benefit to the gross wage. Sage 100 Contractor executes each payroll calculation in the order established by the calculation numbers.
- To use the calculation for paygroup benefit packages only, select the Use in Paygroup Benefits check box.
- To include the calculation on a union report, under Reporting, select the union from the Union drop-down list. Union reports can only be included with the calculations of their own union number. If you are using union reports and have more than one union, you must create a set of calculations for each union.
To include the calculation on certified payroll reports, under Reporting, select the type of benefit in the Benefit list.

You can use the same payroll calculation in different paygroups, but assign different rates. Suppose that in county A you have performed Davis-Bacon work. Recently, you won a Davis-Bacon contract in county B from the same government agency. The governing agency has not changed the calculation methods, but the wage and benefit rates differ. In setting up the paygroups for the new contract, you can use the same benefit calculations but assign different rates to them.

About payroll calculations (Payroll)

Payroll calculations provide the rules for computing deductions, benefits, and employer costs. You can set up payroll calculations manually, or you can create the set of standard calculations supplied by Sage 100 Contractor.

Caution! Setting up payroll calculations can be complex. If you need assistance, consult your business partner.

After you have set up the calculations, you can add them to the employee records. Each employee record maintains its own list of calculation rates, calculation maximums, and quarterly totals for the payroll calculations. On the Calculations tab in the 5-2-1 Employees window, you can edit the calculation rates and maximums for one employee record without affecting the others.

When you compute payroll, Sage 100 Contractor reads the calculation rates and maximums from the employee record, and uses those rates with the payroll calculations. Depending on the type of calculation you want to set up, Sage 100 Contractor: (1) makes certain calculation selections for you that you cannot change; and (2) makes certain suggestions about what you may change:

- Federal and state taxes (Social Security, Medicare and FUTA): Sage 100 Contractor contains the tax tables necessary for computing federal and state income taxes. For each state that your employees work in, set up a payroll calculation to compute the state income tax. While some states do not levy an income tax, the calculation is still necessary to maintain accurate wage information.

  To compute taxes correctly, some states require additional setup in the employee records. For details on setting up tax calculations for specific states and municipalities, see Appendix D—Tax Setup Information

  Note: Do not set up more than one calculation for Tax Type 3 (Employer Social Security) or Tax Type 4 (Employer Medicare). Doing so will cause audit errors.

- Local payroll tax districts. Many counties and municipalities levy income taxes. You can specify the correct local payroll-tax districts and then assign the locales to the appropriate job and employees.

- Calculated amounts that add to or deduct from pay for specific reasons. In some cases, it is necessary to create different payroll calculations for the same purpose. For example you may need different methods to calculate wage garnishments, retirement plans or union deductions.

Building Payroll Calculations

- Creating standard payroll calculations. To get started, we recommend that you take advantage of the standard calculations that Sage 100 Contractor can automatically create for you. If you choose to
create the set of standard calculations, you will need to review and possibly adjust and/or manually add additional calculations later. "About pre-built standard payroll calculations" below

Setting up payroll calculations. You can set up payroll calculations manually by defining each type of calculation that you will need. There are many parameters for each calculation that must be carefully reviewed before setup.

Notes:
- Do not set up more than one calculation for Tax Type 3 (Employer Social Security) or Tax Type 4 (Employer Medicare). Having more than one calculation for these tax types causes audit errors.
- Also, do not set up more than one calculation for Tax Types 5, 6, 11, 12 and 15.

About pre-built standard payroll calculations

Sage 100 Contractor comes with a set of standard payroll calculations. We recommend that you use these standard payroll calculations as a starting point.

You can use the pre-built standard calculations only for a new company that does not already have the calculations set up. It is important to review and modify the standard calculations after you set them up to ensure they meet your regional requirements.

Sage 100 Contractor creates the following calculations:
- Social Security—Employee
- Medicare—Employee
- Federal Income Tax—Employee
- Social Security—Employer
- Medicare—Employer
- Federal Unemployment—Employer (FUTA)
- Per Diem
- Advances
- Workers’ Compensation
- Liability Insurance
- State Income Tax—Employee
- State Disability Insurance—Employee
- State Unemployment Insurance—Employee

Creating standard payroll calculations

If you choose to create the standard calculations, you must do so before setting up any calculations manually.

Even though some states do not have state income tax, the state income tax calculation must be set up in the 5-3-1 Payroll Calculations window so that the Workers’ Compensation report prints correctly. Also, the state income tax calculation must be set up so that W-2 forms calculate correctly.
To create standard payroll calculations

1. Open 5-3-1 Payroll Calculations.
2. On the menu bar, click Options, then click Create Standard Calculations.
3. Carefully review each standard payroll calculation.
4. Some of the account numbers may need to be modified. If you used the Sage 100 Contractor standard 4-digit or 5-digit chart of accounts and have not made modifications, the account numbers will be correct. If you have used or created another chart of accounts or modified one of the standard ones, you will need to review each of the account numbers carefully.
5. For each state tax calculation, you must enter the state abbreviation in the State text box.
6. For the State Disability Insurance and the State Unemployment Insurance calculations, you must enter the Default Rate, Default Maximum, and Max Type.
7. Set up any additional calculations.

Setting up payroll calculations

The taxes to which calculations are subject vary by state or region. Verify the selections with your accountant, or if it is a benefit, the benefit plan administrator.

Caution! Verify that all your calculations are correct before running a trial-compute of your payroll. If you are unsure about the results, contact Customer Support or your business partner for assistance.

To set up payroll calculations

1. Open 5-3-1 Payroll Calculations.
2. In the data control box, enter the number you want to assign the new calculation.
3. In the Description box, enter a brief statement about the calculation.
4. In the Tax Type list, click the type of earning, accrual, or deduction that you are setting up.
5. Depending on the tax type you selected, make additional selections as required for:
   - **Calculation Type.** If you selected None as the Tax Type, you need to specify the type of earning, accrual, or deduction.
   - **Calculation Method.** This list is available if you selected None or 19 - Employee RPP Contributions as the Tax Type. Click the method to use to compute the earning, accrual, or deduction,
   - **Based On.** This list is available if you selected None as the Tax Type and 7 - %Other Calculation for the Calculation Method. Click the type of amount on which to base the payroll calculation.
   - **Default Rate.** Enter the standard calculation rate.

Important! When you use calculation method 17-Tables for federal or state income taxes, Sage 100 Contractor sets the rate. The rate does not appear in the payroll calculation or the employee record.

- **Default Max.** Enter the calculation maximum.
Max Type. Click the type of maximum for the calculation.

Note: If you plan to set maximum wages for workers' compensation codes for states other than Ohio, New York, and Nevada, you must select 4-Wages/Year.

6. Specify the accounts that will be affected by this payroll calculation:
   a. In the Job Expense, Shop Expense, Overhead Expense, and Admin Expense boxes, enter the ledger account numbers to debit for each type of expense.
   b. In the Credit Account box, enter the liability account number to credit.
   c. In the Credit Subaccount box, enter the ledger subaccount number to credit.

   Note: If you want to use the employee number as the subsidiary account number, click Use employee# as subaccount.

Important! The Credit Account and Credit Subaccount are typically liability accounts. You must specify a Credit Account, but a Credit Subaccount is only necessary dependent upon your general ledger setup.

7. Under Subject to, verify the deductions to which the calculation is subject.

8. Under Tax Area:
   a. If the calculation is for a specific state, enter the state abbreviation in the Tax State box.
   b. If the calculation is for a specific local payroll tax district, click the district number in the Tax Locale list.

9. Under Reporting:
   a. To include the calculation on a union report, select the union from the Union list.
   b. To include the payroll calculation on certified payroll reports, select the type of benefit in the Benefit list.
   c. To report the calculation total in box 11, 12, 13, or 14 on W-2 forms, enter the box number in the W-2 Box field.
   d. To include a special code on the W-2, enter the code in the W-2 Code box.

10. Select the following check boxes that apply to the payroll calculation:
    - Use in Paygroup Benefits
    - Display on Check
    - Disposable Earnings
    - Default to New Employees

11. On the File menu, click Save.
Chapter 3: Additional Details

About calculations in employee records

When setting up a new employee record, Sage 100 Contractor inserts the package of default payroll calculations, including the calculation rates and maximums, on the Calculations tab. Each employee record has its own set of payroll calculation rates, maximums, and totals. You can edit the calculation rates and maximums in one employee record without affecting others. When you compute payroll, Sage 100 Contractor reads the calculation rates and maximums from the Calculations tab.

Before editing the individual calculation rates and maximums, familiarize yourself with how payroll calculations are set up. Most calculations that refer to tax tables do not allow editing. Sage 100 Contractor determines the tax table number, but does not display the data in the Calculations tab.

You can manage the marital status settings, allowances, and withholding amounts for federal and state tax calculations. For example, Steve works in Kansas and Nebraska. In Kansas, Steve claims married-joint status, but in Nebraska, he claims married-separate status. In the Marital column, you can enter the appropriate marital status for the Kansas and Nebraska income tax calculations.

You can also control whether a payroll calculation is active or inactive. When you type No in the Active cell for a calculation, Sage 100 Contractor does not include that payroll calculation in the compute for timecards. For example, John was given a $500 payroll advance, and the Payroll Advances calculation in John’s employee record was set up to recover $100 per paycheck. But John has said that the next few weeks are difficult and that he would like to suspend the repayment for a little while. In John’s employee record, type No in the Active cell of the Payroll Advance calculation. When you are ready to resume recovering the advance, type Yes in the Active cell of the Payroll Advance calculation.

Contractors who work on prevailing-wage jobs are required to match the difference between prevailing wages and benefits, and actual wages and benefits paid to each employee. For each employee who works the prevailing-wage job, you can enter the credit in the Offset column. When you compute payroll, Sage 100 Contractor applies the credit. To manage payroll for prevailing-wage jobs, set up paygroups.

### Notes:
- Some states use additional tax tables to collect county taxes with the state taxes. To calculate the correct taxes, enter the tax rate or table number in the Table# cell of the calculation.
- You can withhold an additional flat amount for federal taxes or state taxes. To withhold a flat amount for a calculation, enter the amount in the Add W/H cell of the calculation.

Adding payroll calculations to employee records

When setting up a new employee record on 5-2-1 Employees, Sage 100 Contractor inserts the package of default payroll calculations, calculation rates, and maximums on the Calculations tab. You can insert additional payroll calculations at any time.

To add payroll calculations

1. Open 5-2-1 Employees.
2. Click the Calculations tab.
3. In the Calculation column, in an empty cell, click once, and then click the down arrow button to display the Payroll Calculations Lookup window.
4. Select and insert the calculation(s).
**Tip:** Alternatively, you can right-click in an empty cell of the Calculation column and select from the menu of Pick Lists. Press the F5 key to open the Payroll Calculations Lookup, or F8 to open the Payroll Calculations Lookup window as a Picklist.

**About tax tables for setting up federal and state tax calculations**

Sage 100 Contractor contains the tax tables necessary for computing federal and state income taxes. For each state you work in, create a payroll calculation for state income tax. The calculation is necessary to maintain the correct gross wage totals for each employee, and to ensure accurate state quarterly reports, state tax reports, and W-2 forms.

Although some states do not have state income tax, state income tax calculations must be set up:

- In the 5-3-1 Payroll Calculations window, so that reports based on state wages are accurate and print correctly.
- In the 5-2-1 Employees window for employees, so that payroll calculations compute correctly.

If you work in a state that does not levy an income tax, you still need to create a payroll calculation. For those states, a tax is not calculated, but Sage 100 Contractor stores the state wage for state reports. In addition, some calculations use the state wage to compute additional deductions such as state unemployment or disability. For those types of calculations, it is important to select the State Income Tax check box. Otherwise, the payroll calculation may not compute the deduction correctly.

**About local payroll taxes**

Many counties and municipalities levy income taxes. In the Local Payroll Taxes window, set up the table of local payroll tax districts and their rates. You can then assign the locales to the appropriate job and employee records. If an employee lives in a locale, add the locale to the employee’s record. If a job site is located in a locale, add the locale to the job record.

There are a variety of ways to set up the districts:

Some districts base the taxes on whether the employee lives inside or outside the locality. The resident rate applies to employees that work and live in the same locality, while the non-resident rate applies to employees who work in the locality but live elsewhere.

During the payroll computation, Sage 100 Contractor compares the locale in the job record to the locality in the employee record. If the districts match, Sage 100 Contractor computes taxes at the resident rate. If the district numbers differ, Sage 100 Contractor computes taxes at the non-resident rate.

In some regions, employees are subject to several taxes, such as city and county income taxes. As Sage 100 Contractor only lets you assign one locality to a job record, employee record, or timecard line, you can combine districts in the Local Payroll Tax window to form a new district. You can then assign the combined district as needed.

When a local payroll tax applies to employees regardless where they work, you can set up the district to work like state income tax.

When employees work multiple states but there are no local payroll tax districts, use the districts to control how Sage 100 Contractor computes state income tax for each timecard line.
Each locality requires a corresponding payroll calculation. In most circumstances, each payroll calculation uses calculation method **17-Tables**, and refers to the table of localities for the rates.

**About calculation types**

The calculation type determines how a payroll calculation affects a timecard. For example, when you assign a payroll calculation **1-Deduct from Employee**, Sage 100 Contractor deducts the result of the calculation from the employee’s wages.

For most payroll calculations, the program determines the calculation type and the taxes that a calculation is subject to based on the tax type.

If you select tax type **0-None**, however, you can select the calculation type.

**Calculation type 1-Deduct from Employee**

**Payroll Taxes.** For each payroll tax, set up a payroll calculation.

If your company performs work in different states, set up a payroll calculation for every state in which your employees work, regardless of whether the state levies an income tax. In addition, set up a payroll calculation for each local payroll tax district, such as city and county.

At the calendar year-end, verify the tax rates and maximums for each calculation. Sage 100 Contractor provides Federal and State tax updates each year.

**Payroll Advance.** Create a calculation for payroll advances. Sage 100 Contractor automatically recovers the advance for you.

**Tool Purchases.** Some companies allow employees to purchase personal tools from vendors using the company account. You can set up a payroll calculation to deduct the employee’s purchases from his or her paycheck.

When you post the vendor’s original invoice for the tool purchase, post it to the **Small Tools** account in the **Overhead Expense** range of accounts. To then deduct the tool purchases from an employee’s paycheck, set up the payroll calculation to post a credit to the **Small Tools** account. Because the amount deducted from an employee’s paycheck varies based on the cost of the tools purchased, select calculation method **18-Variable (manual calculation)**.

While you can deduct the cost of tools from the employee's paycheck, it is a better practice for employees to reimburse tool purchases through personal checks, made payable to your company.

**Health Insurance.** Create a payroll calculation to deduct the employee’s portion of the cost for medical insurance. Usually this is a fixed amount per month.

If you need to deduct the health insurance each pay period, convert the monthly amount to a per-period amount. From the monthly amount, compute the annual amount and divide by the number of pay periods in a year. If your company pays its employees weekly, for example, divide the annual amount by 52. Then enter the per-period amount in each employee’s record on the **Calculations** tab.

When employees cannot earn paychecks regularly, due to weather or other circumstances, set up the **Health Insurance** calculation with a maximum type of **6-Dollars/Month**. Then on the **Calculations** tab in the employee records, enter an accelerated rate and a monthly maximum for the payroll calculation.
Gamishments. (Child support, Previous Year Income Taxes, Court Judgments, and so on) Create a payroll calculation for each type of garnishment. If similar garnishments require different methods of calculation, create a separate calculation for each garnishment.

Suppose you need to garnish the wages of two employees for child support, and a third employee’s wages for back taxes. The first employee’s garnishment is for a set dollar amount each pay period and the second employee’s garnishment is for a percentage of the net pay. Set up two separate calculations for child support garnishments, though both can post to the same payable account. Then set up a third calculation for the garnishment of back taxes, which posts to a different payable account.

If you want to post each garnishment to a different ledger account, create the separate ledger accounts in the Current Liabilities range of accounts. Select the Employee Number as Subaccount check box to post the garnishment to a subsidiary ledger account using the employee’s record number as the subsidiary account number.

Some methods of computing garnishments might be too complex for Sage 100 Contractor to automatically calculate, such as a percentage of the net pay with a minimum or maximum amount. In this case, set up a payroll calculation with a variable calculation method.

Pension Plans. Some businesses set up pension plans such as a 401(k), to which employees contribute. In general, 401(k) deductions are not subject to Federal and state income taxes. Check with your state agencies to determine what is taxable.

Many pension plans allow employees to contribute a flat amount or a percent of the employee’s paycheck. You may need to create two payroll calculations and assign the appropriate calculation to each employee based on how he or she wants to contribute.

To create a pension plan deduction, set up the payroll calculation with tax type 19-Elective Deferral and calculation type 1-Deduct from Employee. Because each employee can choose the flat amount or percent of his or her paycheck to contribute, enter the employee’s amount or rate in the Calculations tab of each employee record.

To post the credit, set up a separate ledger account in the Current Liabilities range of accounts. Select the Employee Number as Subaccount check box to post each employee’s contribution to a subsidiary ledger account using the employee’s record number as the subsidiary account number. The subsidiary accounts help you manage the individual employee contributions, and know what amount to pay on behalf of each employee.

Calculation type 2-Add to Gross

Cash benefits for prevailing wage. Non-union contractors working Davis-Bacon or prevailing-wage jobs must pay employees a cash equivalent to the union wage and benefits. After setting up the paygroups, set up a payroll calculation for each benefit, such as vacation, pension, and health and welfare.

Because the benefit is being paid as cash, set up the calculation using calculation type 2-Add to Gross, and post the credit to the ledger account number of the payroll checking account. Sage 100 Contractor adds the result of the calculation to the employee’s gross wage.

Tip: You can include cash benefits in the Certified Payroll report. In the Benefit list, click the type of benefit the calculation represents.
### Calculation type 3-Employer Cost

**Note:** Calculations type 3-Employer Cost can be used can be used to accrue virtually any type of employer cost.

**Payroll Taxes.** For each payroll tax, set up a payroll calculation.

If your company performs work in different states, set up a payroll calculation for every state in which your employees work, regardless of whether the state levies an income tax. In addition, set up a payroll calculation for each local payroll tax district, such as city and county.

At the calendar year-end, verify the tax rates and maximums for each calculation. Sage 100 Contractor provides Federal and State tax updates each year.

Workers’ Compensation Insurance. When you set up a payroll calculation for Workers’ Compensation, Sage 100 Contractor uses the rates set up in the **Workers’ Compensation** window. Select **17-Tables** as the calculation method.

Liability Insurance. You can set up the liability insurance calculation to use the rates from the Workers’ Compensation window. Select **17-Tables** as the calculation method, and credit the account to which you post the insurance payments.

Generally, liability insurance covers field employees and sometimes the owner, but not office employees. For each exempt employee, change the payroll calculation’s rate to 0 on the **Calculations** tab of the employee record.

Some companies compute the liability insurance as a percent of gross pay. In the **Tax Type** list, click **0-None**. In the **Calculation Method** list, click **1-Percent Gross Pay**. The rate is usually the same as the payroll rate on the insurance policy.

Health Insurance. Set up a payroll calculation to deduct the employer’s portion of the cost for medical insurance. The amount is usually a fixed rate per month.

To deduct the health insurance each pay period, convert the monthly amount to a per-period amount. First, convert the monthly amount to an annual amount, then divide by the number of pay periods in a year. If your company pays its employees weekly, for example, divide the annual amount by 52.

**Pension Plans.** Some businesses set up pension plans, such as a 401(k), to which employers contribute. In the **Tax Type** list, click **0-None**. In the **Benefit** list, click **2-Pension** to include the matching amount on Certified Payroll reports.

To create a pension deduction, set up the payroll calculation as follows: tax type **0-None** and calculation type **3-Employer Cost.** Because each employee can choose to contribute either a flat amount or percent of his or her paycheck, you might have to create two calculations.

To post the credit, you can post to the same account used to post the employees’ deductions for the pension plan, or you can set up a separate ledger account in the **Current Liabilities** range of accounts. Whether you post the employer portion of the pension plans to subsidiary accounts depends on your particular needs.

Union shops or open shops that perform Davis-Bacon or prevailing-wage work should not use subsidiary accounts to track the individual matching amounts. To make the payment, each subsidiary account would have to be referenced on the check. Instead, you can use the certified payroll reports to track the amounts paid. If you are using paygroups, you need to enter the pension rates in the **Paygroup Benefits** window.
Select the **Employee Number as Subaccount** check box to post each employee’s contribution to a subsidiary ledger account using the employee’s record number as the subsidiary account number. The subsidiary accounts help you manage the individual employee contributions, and know what amount to pay on behalf of each employee.

**Tool Use:** You can recover the cost of small tools by setting up a calculation for a flat rate per hour that applies to all working field employees. To determine the hourly rate, look at the amount your company spent purchasing small tools for a time, such as the previous year. Then divide that amount by the number of hours worked by field employees during the same time. For employees that do not work in the field, change the rate to 0 in the Calculations tab in the employee records.

**Calculation type 4-Add/Deduct**

**Vehicle use.** Some companies provide a vehicle to an employee as a benefit.

Set up the payroll calculation with calculation type **4-Add/Deduct** (taxable). The calculation adds the dollar value to the gross wages, computes the taxes, and then deducts the dollar value from the gross wages. The calculation results in an increase to the taxable wage.

**Union Vacation.** Contractors are responsible for computing the taxes for vacation pay and filing the necessary reports. When dealing with two or more unions, you might need to create a separate payroll calculation to compute the union vacation for each union local.

Set up the payroll calculation with calculation type **4-Add/Deduct** (taxable). The calculation adds the dollar value to the gross wages, computes the taxes, and then deducts the dollar value from the gross wages. The calculation results in an increase to the taxable wage.

To include the calculation in the default set of paygroup benefits, select the **Use in Paygroup Benefits** check box.

**Calculation type 5-Accrued Hours**

You can use calculation type **5-Accrued Hours** to create a calculation that builds up hours. For example, you could use this calculation to keep track of hours used to determine an employee’s vacation time.

A payroll calculation that uses calculation type **5-Accrued Hours** does not post to the general ledger or create job costs.

**About 5-5-1 Daily Payroll Entry**

You enter payroll data on the **5-5-1 Daily Payroll Entry** window daily for all the employees as well as for allocating equipment use. From the daily entries, you can generate daily reports to review the daily costs of labor and equipment use.

You can attribute an employee’s time to jobs, operation of equipment on jobs, or the repair and maintenance of equipment. Suppose Dan spends the afternoon repairing the engine of a backhoe. To make the repairs, Dan uses a forklift to lift the engine out of the backhoe. On a single line, you can enter Dan’s time spent repairing equipment, what piece of equipment was repaired the backhoe—and, what equipment was operated—the forklift.

You can also enter time for equipment at the job site that does not require an operator. For example, a generator does not require an operator, but you charge for the time it is in use and idle. On a single line, you can enter both the operated and idle time.
You might find this additional functionality beneficial too. The related scope of work recorded in 6-11-6 Daily Field Report line notes from both employees and equipment grids can be imported into 5-5-1 Daily Payroll Entry using the Options > Import Daily Field Report. This provides a way for that information to become part of your payroll and job costing records.

The 5-5-1 Daily Payroll Entry window only allows you to enter times for employees who worked jobs or repaired equipment and times for equipment that was used. The 5-5-2 Payroll Records window allows you to enter records for salary, bonuses, adjustments to deduction and benefit balances, startup data, advances, or third-party sick pay.

At the end of a payroll period, you can convert the daily payroll records into timecards. Each timecard contains the hours worked by an individual employee. After conversion, you can only review timecards in the Payroll Records window.

**Union Payroll (Payroll)**

Sage 100 Contractor supports union payroll with both payroll calculations and specific union payroll reports.

After you have identified your unions, most of the details of union payroll are handled via paygroups. Please review the paygroup concept.

Specialized union reports are available which show the details of all benefit calculations on either a paygroup or employee basis.

**Workers' Compensation—Split Rates (Payroll)**

In a split rate system for workers' compensation, a category of work uses two different rates. Some states, such as California, use a two-tiered system of rates based on employee pay. The wages an employee earns determines the rate at which the insurance company computes Workers' Compensation.

Sage 100 Contractor also allows one employee to be charged at different rates at a job depending upon the task being performed. This feature offers the potential for great savings by the contractor.

**About Workers' Compensation Classification (Payroll)**

Sage 100 Contractor provides methods for you to handle virtually any classification of workers' compensation for your employees. Taking full advantage of this capability is key to minimizing your labor burden.

You can set up workers' compensation codes, rates, and experience modifiers. Sage 100 Contractor uses the table in conjunction with the workers' compensation payroll calculation to compute the premium for each code category. How you set up the workers' compensation codes depends on the requirements for each state:

- Some states use two-tiered codes, where two rates apply to a single category of work.
- Some states require the employer to pay for general liability insurance. Often the liability rates are based on the risk groups, but are not affected by the experience modification.
- Some states use a dollar per hour rate instead of a percent; some use both.
- Some states do not require subcontractors to carry workers' compensation insurance. Often the general contractors carry the liability insurance burden for the subcontractor.

As you set up your system, use the compensation codes from the insurer's policy or report whenever possible.
Direct Deposit (Payroll)

Direct deposit allows your employees to have their paychecks deposited directly into their bank account. Banks require electronic delivery of payroll information by companies wanting to provide employees with direct deposit. Sage 100 Contractor supports the creation of a file in automatic clearing house (ACH) format. You can then send this file to your bank. Your bank will extract records from the file and create files that are routed through ACH providers to the various employee banks.

Notes:

- Contact your bank to determine any delivery requirements, including encryption, additional file format requirements, or other requirements. After establishing and agreeing on a method of delivery with your bank, you can create the file and deliver it in the agreed-upon method.
- Whenever any changes are made to your direct deposit file format by changing any of the formatting options, you should contact your bank and request a retest to be sure your bank is ready for the changes.
- After creating the Direct Deposit File, Sage 100 Contractor prompts you to print a Direct Deposit File Report that shows your Direct Deposit File information. If you do not print that report at that time and need to reprint the report, use Options > Reprint Direct Deposit Report.

Two documents can be created during a direct deposit run: the Direct Deposit File and the Direct Deposit File Report.

- Direct Deposit File. The Direct Deposit file is created in Automated Clearing House (ACH) format and is saved as a .txt file used by the bank. By default it is saved in the x:\\[ServerName]\ [CompanyName]\Direct Deposit folder (where x: is your network drive). The next time you save your direct deposit file, Sage 100 Contractor defaults to the directory where the file was last saved. The exact location of your direct file appears on the Direct Deposit File Report.

- Direct Deposit File Report. The generated report is saved in the \[ServerName]\ [CompanyName]\Reports folder as an .rtf or .pdf.

Printed checks have a unique check number and an electronic deposit number that correspond to the payroll record number. Sage 100 Contractor users with checks pre-printed with check numbers should process check runs in sequence.

Printing direct deposit payroll checks creates and prints a non-negotiable check and supplies the employee with a record of the payroll. You have three options for printing direct deposit checks in 5-2-4 Payroll Checks.

Direct deposit is limited to employee payroll. Sage 100 Contractor does not support electronic payment or electronic transfer of funds for such things as:

- Federal, state, or local taxes
- Child care support payments
- Wage garnishment

Trial Compute (Payroll)

This is the initial calculation of payroll during a payroll cycle. During a compute, the program calculates the wages, deductions, benefits, and employer costs for each timecard.
After a trial-compute, you can review the individual payroll records, check the accuracy of the payroll calculations, and make any final adjustments. Before the final-compute, you can override a payroll calculation in a specific record and provide the amount you want Sage 100 Contractor to use.

**Payroll Final Compute (Payroll)**

At this point payroll expenses are posted to job costs. When a final-compute is completed, Sage 100 Contractor changes the status of the records to computed and creates the job costs.

In the employee records, the program updates the quarterly and year-to-date totals for gross wages, Social Security, and Medicare. The program also updates the quarterly totals of the payroll calculations.

Once you have finalized payroll, you can print payroll checks and post the records. If the posting period has changed between the time of the final compute and posting to the general ledger, Sage 100 Contractor updates the posting period of the job cost records.

**Post to General Ledger (Payroll)**

You can enter timecards, compute payroll, and even print payroll checks without posting the payroll records. When you are ready, you can post individual payroll records or all payroll records for a specified pay period.

When you post payroll, Sage 100 Contractor:

- Debits gross payroll:
  - Job costs post to the direct expense account. If you have selected the Post Payroll to WIP check box in the job record, payroll posts to a WIP account. If the WIP account uses subsidiary accounts, payroll posts to a subsidiary account that uses the job number as the account number.
  - Equipment repair or maintenance costs post to the equipment/shop account.
  - All remaining costs post to the overhead or administrative account, which is determined by the employee position.
- Debits payroll expenses to the ledger accounts as indicated in the payroll calculation.
- Credits net payroll to the checking account entered in the Payroll Posting window.
- Credits the ledger accounts as indicated in the payroll calculation.

**Tip:** You can receive a warning when you try post payroll to a period that does not match the check date or when the end date of the pay period falls outside the posting period. If you want to receive a warning, select the Verify Check Date Is within Posting Period option or the Verify Pay Period Ending Date Is within Posting Period option in the 5-2-6 Post Payroll to GL window. You can choose whether to post the payroll record if you receive this message.

If you do not specify which records or pay periods to post, Sage 100 Contractor posts all payroll records assigned 2-Computed or 4-Reverse. After posting is complete, Sage 100 Contractor changes records with status 2-Computed to status 3-Posted, and records with status 4-Reverse to status 5-Void.
**Timecard (Payroll)**

Sage 100 Contractor offers a variety of ways to create timecard records for your employees. You can directly enter timecard records on an employee by employee basis or use daily payroll reports to enter the records by day for many employees. At the press of a button, you can then create detailed Timecard records that will be job costed.

After timecards have been created, however, the costs are available on committed cost, cost to complete, and cost vs. budget reports for you to manage jobs. When you run Final Compute in 5-3 Compute Payroll, Sage 100 Contractor posts the costs for labor to the general ledger and creates the job cost records.

Several third-party vendors provide applications for timecard entry via the Web and PDA devices.

**Certified Payroll (Payroll)**

To verify the payment of the prevailing wages to employees working a Davis-Bacon or prevailing-wage project, government agencies require contractors to submit Certified Payroll reports. The governing agency determines the frequency with which you must submit the reports.

In 5-5-1 Daily Payroll Entry or 5-2-2 Payroll Records, type Yes in the Certified text box to include the wages benefits of a payroll line in the Certified Payroll report. If you type No or leave the Certified text box blank, Sage 100 Contractor does not include the wages in the payroll data for the Certified Payroll report.

Certified reports 5-1-6-21 Certified Payroll Report, 5-1-6-31 Department of Labor, and 5-1-6-51 Alaska Certified Payroll have the option to exclude or include social security numbers and mask the numbers if desired.

**Tip:** You can print a Certified Report or a Minority Report from 5-1-6 Certified Payroll Report.

**Production and Project Management Details**

**Project Work Center (Project Management)**

The first time you open the Project Work Center, the job box displays the last job entered in the current company. However, you can also view any other available jobs in that company. After that, the last accessed job is the default when you open Project Work Center. If you have not created any jobs in your company, you are prompted to create one from the 3-5 Jobs (Accounts Receivable) window when you open Project Work Center.

Project Work Center displays the following information for a selected job:

- A customizable menu tree displaying accessible menu commands.
- The Project Hot List.
- Contact and current financial information about the selected job.

**Important!** All selections and defaults are user-specific and company-specific.
**Customizable Menu Tree**

The left side of the window displays a menu tree for accessible Sage 100 Contractor menu commands for the selected job. Selecting a menu command displays the form or record pre-loaded with the job’s information for you to view or update.

In some cases, a list of associated items of that type for the selected job appears and you can then select the appropriate item. The following selections display a list:

- 3-2 Receivable Invoices/Credits
- 3-7 Progress Billing
- 4-2 Payable Invoices/Credits
- 6-4-1 Change Orders
- 6-6-1 Purchase Orders
- 6-7-1 Subcontracts

The menu tree defaults with all possible menu commands available. This is customizable through the *Customize Project Work Center Menu* window.

**Project Hot List**

The upper right side of the window displays the *Project Hot List*. The *Project Work Center* lets you view and manage information from the standard tables in the *Project Hot List*. With *Document Control*, you also have access to the enhanced functionality available from the *6-11-9 Project Hot List* window.

**Project Work Center Job Contact and Financial Data**

The bottom of the window displays important information at a glance for each selected job. This information is “display only” and cannot be edited. However, as information is changed in Sage 100 Contractor for a specific job, this information is updated.

**Project Work Center Desktop Shortcut**

Job information is available directly from the *Sage 100 Contractor Desktop* by creating a desktop shortcut icon in the *6-12 Project Work Center* window. This feature enables you to view important data and manage all your jobs from one location. *Project Work Center* is highly customizable for each user’s needs.

**Important!** You must create the desktop shortcut once. The *Project Work Center* shortcut will then be accessible from the desktop or in the *6-12 Project Work Center* window.

**Hot List (Project Management)**

**Note:** This functionality is available only if you have the *Document Control Module*.

The *Project Hot List* is a record of items that require immediate attention. You can display a hot list by job or by supervisor. You can then drill down to review a specific record.

You can access the *Project Hot List* from the *6-11-9 Project Hot List* or the *6-12 Project Work Center* windows.
Important! Selection by supervisor is not available when accessing the Project Hot List from 6-12 Project Work Center.

You can include the following standard information on the Project Hot List:

- Invoices
- Change orders
- Purchase orders
- Subcontracts
- Proposals
- Progress bills
- Loan draws
- Unitary bills
- Recurring payables
- Recurring receivables

Optional information you can include on the Project Hot List:

You can display more items in your Project Hot List, from both the 6-11-9 Project Hot List and 6-12 Project Work Center windows, such as:

- Requests for information
- Requests for proposals
- Transmittals
- Submittals
- Plan records
- Daily field reports
- Punch lists
- Correspondence

Grid Files (Project Management)

Grid files provide a quick way to build:

- Budgets
- Takeoffs
- Proposals
- Schedules

Essentially, the grid files are parts of full grids that can be imported into the four named documents. This provides a handy way to duplicate complex work from job to job.
About change orders

You use the 6-4-1 Change Orders window to manage changes to a prime contract or subcontract. Change orders let you track changes independent of a project’s budget, providing a clear audit trail for pending, approved, and refused changes.

Change orders are closely integrated with subcontracts. When you use the 6-4-1 Change Orders window to create a change order for a subcontract, information is displayed on the 6-7-1 Subcontracts window in the Changes, New Contract, and Remaining columns. This tight integration provides more control over your contracts and your invoicing by providing accessible information.

Depending on the type of change work you need to perform, you can enter change orders that alter the job’s budget, proposal, or subcontracts, or any combination of the three.

The 6-4-1 Change Orders window has two tabs:

- You use the Prime Change Details tab to enter changes to costs that affect the bid amount.
- You use the Budget and Sub Change Details tab to enter cost changes that affect your budgeted costs, such as subcontract changes or work for which you do not want to charge the client.

Prime Change Details tab

The Prime Change Details tab allows you to track changes to a project and segregate changes to the contract (proposal) from changes to your budget (costs).

Prime changes are change orders that alter the job proposal. They let you track changes independent of a project proposal, providing a clear audit trail for pending, approved, and refused changes.

From approved prime changes, you can create receivable invoices and purchase orders. When you select the Create A/R Invoice or Create Purchase Order command on the Options menu, Sage 100 Contractor opens the appropriate window and inserts the relevant information. To complete the invoice or purchase order, you enter the parts and any additional information.

Budget and Sub Change Details tab

Change orders have two components:

- Prime Change Orders
- Budget and Sub Change Orders.

Change orders allow you to track changes to a project and segregate changes to the contract (proposal) from changes to your budget (costs). Depending on the type of change work you need to perform, you can enter change orders that alter the job budget, proposal, or subcontracts, or any combination of the three. Overall, change orders provide a convenient way to manage changes to a contract or subcontract.

Subcontracts work in conjunction with change orders and accounts payable, providing you with better control over change work and billing. You can review billings, approved and open change orders, or a summary of the subcontract information. You can also set up retention for a subcontract. When you create an invoice for the subcontract, the program uses the rate indicated in the subcontract record.

Because the Sub Change Orders window provides for managing changes to a budget or subcontract, you may enter cost changes that affect your budgeted costs (such as subcontract changes) or cost changes that affect work for which you do not want to charge the client.
When changes are approved, Sage 100 Contractor reflects the changes to costs in the contract and job cost reports, but the original budget remains unchanged. From approved change orders, you can create receivable invoices and purchase orders. When you select the Create Invoice or Create Purchase Order command on the Options menu, Sage 100 Contractor opens the appropriate window and inserts the relevant information. To complete the invoice or purchase order, you enter the parts and any additional information.

You can also record which plans and documents you send as attachments with the change order, as well as to whom you route the change orders.

**Attachments and Routing**

The 6-4-1 Change Orders window also supports Attachments and Routing. You can drag and drop files onto the window to create an attachment that can be emailed to customers or printed. The Routing command allows you to keep track of where and to whom you have sent attachments.

**Tip:** The Attachments command is located under Edit > Attachments.

**Upgrade check box**

Another important feature of the 6-4-1 Change Orders window is the Upgrade check box. The Upgrade check box controls what information is included on 6-1-13-41 Homebuilders reports. For example:

- To include an Upgrade Price on the Homebuilders reports and add it to the Sales Price Totals on the reports, you must select Upgrade, and that specific change order must have an approved Prime Change Order amount.
- To include an Upgrade Budget on the Homebuilders reports and add it to the Total Budget, you must select Upgrade, and that specific change order must have an approved Budget amount.

**Direct Expense (Project Management)**

When you post payable transactions to the Expense range of accounts, Sage 100 Contractor displays the Job Cost Distribution window.

In the Job Cost Distribution window, you can break apart costs to create individual line entries that reference jobs, phases, cost codes, and cost types. You can also select jobs or phases using a Picklist and distribute the cost equally among the selections.

When job costing a transaction from the 1-1 Checks/Bank Charges window or the 4-2 Payable Invoices/Credits window, Sage 100 Contractor uses the vendor record to determine which cost code and cost type to use. If the vendor record does not contain a cost code or cost type, you must supply the information.

The Ledger Total box displays the total debits less credits posted to Direct Expense or WIP accounts. As you enter the costs, Sage 100 Contractor shows the total amount costed in the Job Cost Total box. To save the job cost record, the amount in the Job Cost Total box must equal the amount in the Ledger Total box.

**Committed Costs (Project Management)**

This report allows you to see what the committed costs are on a job. The committed costs are monies that you’ve committed to spend but have not spent yet. The report looks to new or unfilled purchase orders, subcontracts, and payroll records that have not been final-computed. It allows you to determine the
percentage of labor burden applied to all open payroll records. It calculates the remaining budget based on the budget plus changes, less costs to date and committed costs.

**Cost to Complete (Project Management)**

**Caution!** The Cost to Complete report relies on accurate and up-to-date job costs. Be sure to post all job costs and enter any recent change orders before updating the report.

In the 6-8-1 Cost to Complete window, you can generate a report estimating the costs necessary to complete a project currently under construction. When you select the job and phase and update the data, Sage 100 Contractor retrieves the current budget, job costs, and the gross wages for uncompensed payroll records. Over the course of the project, you can update the current budget and job costs in the Cost to Complete window to create a new report.

Enter the estimated percent of work completed or costs to complete the project, and calculate the report. If you provide the percent of work completed, Sage 100 Contractor computes an estimate of the remaining costs to complete the project and the amount by which you are over or under budget. If you provide the estimated costs to complete the project, Sage 100 Contractor computes the percent of work completed and the amount over or under budget.

While the computed payroll records include the labor burden, the gross wages for uncompensed payroll records do not. To increase the accuracy of the report, you can provide a labor burden rate, which Sage 100 Contractor uses to calculate and add in the estimated labor burden for uncompensed payroll records.

**Reporting Details**

**Form Design (Reporting)**

Every report, document, or letter that you generate uses a form design. A form design is a template for the layout of a page or pages. With 13-5 Form/Report Page Design, you can edit any of the form designs supplied with Sage 100 Contractor, or create entirely new forms. You can change the graphic elements and layout of the form, as well as the boilerplate text. This is especially useful when a company has several different businesses, and needs to use different forms for each business.

Before creating a report, it is important to understand how 13 Report Writer and Form/Report Page Design work together.

- In 13-5 Form/Report Page Design, you create the page layout for a single page form or a multi-page form that includes text, fields, and calculated fields. Form designs also use a detail box, which indicates where the details of the report will be placed.
- In 13-3 Report Writer, you create the body of the report that appears in the detail box of the form design. In the design of the report details, you can include text, fields, and calculated fields. In addition, you can control when a report prints on a new page or on an entirely new form.

13-5 Form/Report Page Design provides the ability to create multi-page forms. Suppose that you always send a cover letter with each proposal to potential clients. You can incorporate both the cover letter and the proposal forms in a single design. Then when you print proposals, the cover letter always prints with the proposal. A form can have up to 100 pages, each of which you can format differently.
Creating new forms

**Note:** Sometimes it is quicker to create a new form from an existing form if you only have to make a few changes or additions.

To create a new form, open **13-5 Form Report/Page Design**. The **13-5 Form Report/Page Design** window appears and displays a blank page on which you can begin creating your new form.

**Creating new forms using existing forms**

It may be easier for you to use an existing form to create a new form. For example, in the **3-2 Report Printing** window, on the **Report Criteria** tab, you see a list of reports. When you click a report in the **Report Criteria** list, the form upon which the report is based is displayed in the **Report Form** drop-down list.

<table>
<thead>
<tr>
<th>Report</th>
<th>Report Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>21—Receivable Invoice</td>
<td>System.Invoice_AR</td>
</tr>
<tr>
<td>22—Receivable Invoice—with Notes</td>
<td>System.Invoice_AR</td>
</tr>
<tr>
<td>23—Receivable Invoice—Retention</td>
<td>System.Invoice_AR_Retention</td>
</tr>
<tr>
<td>24—Receivable Invoice—Retention; with Notes</td>
<td>System.Invoice_AR_Retention</td>
</tr>
<tr>
<td>31—Receivable Credit</td>
<td>System.Credit_AR</td>
</tr>
</tbody>
</table>

The system forms follow a specific naming pattern, for example, **System.Invoice_AR**. For the new report to appear in Sage 100 Contractor in the area in which you would want it to appear, it must be saved with a similar naming scheme. For example, **YourName.Invoice_AR**. You do not need to preserve "System" in the name, you must retain the **.Invoice_AR** in the name. The "System" designation is intended to identify the forms that are included with the program installation. Forms that you create or modify should not include "System" in the name.

**Note:** Form designs are listed alphabetically in the report form list. To see your new forms listed before the "System" reports, use a name that will appear before the word system.

When you open a system report and save it with a new name, it is saved by default to the **\Report Forms folder**; however, you can choose to save it in a different folder. If you save it to a different folder, it will not appear in the program.

**To create a new form using an existing form**

1. Open the **3-2 Receivable Invoices/Credits** window (for example).
2. Click the **Print Records** button.
3. On the **3-2 Report Printing** window, in the **Report Form** list, click the drop-down arrow, and then select the form design that you want to edit.
4. From the **Edit** menu, select **Form Design**.
6. From the File menu, select Save.
7. On the Save File window, name the new form and then click Save.

When you need to make a large number of changes, it might be easier to create a new form from scratch in the 13-5 Form/Report Page Design window.

**Editing existing forms**

**To edit an existing form design in 13-5 Form/Report Page Design**
2. Select File > Open.
3. Select the form design that you want to edit.
5. Select File > Save.

**To edit an existing form design from a Report Printing window**
1. Open any Report Printing window, for example 3-2 Receivable Invoices/Credits.
2. Click the Print Records button.
3. Select the form design that you want to edit.
4. From the Edit menu, select Form Design.
5. On the 13-5 Form/Report Page Design window, edit the form.

**Previewing forms**

**To preview a form within 13-5 Form/Report Page Design:**

From the 13-5 Form/Report Page Design window, select Pages > View Page.

**To preview a form from within a Report Printing window:**
1. Open the report and select the Report Form for preview.
2. Select Edit > Form Design.

**Reducing the document size when previewing forms**

When previewing a form, you can reduce the size of a document displayed in the Screen Review window.

In the Screen Review window, select View Options, then select the percentage size (100%, 85%, 70%, or 50%) at which you want to view the report.

**Report Writer (Reporting)**

**13-3 Report Writer** provides tools that allow you to create custom reports to access information stored in the Sage 100 Contractor databases. With 13-3 Report Writer, you can modify existing reports or create entirely
new reports for your company’s needs.

Before creating a report, it is important to understand how 13-3 Report Writer and 13-5 Form/Report Page Design work together. In 13-5 Form/Report Page Design, you create the page layout for a single page form or a multi-page form that includes text, fields, and calculated fields. Most form designs also have a detail box, which indicates to Sage 100 Contractor where the details of the report will be placed.

In 13-3 Report Writer, you create the body of the report that appears in the detail box of the form design. In the design of the report details, you can include text, fields, and calculated fields. In addition, you can control when the report prints on a new page or an entirely new form.

13-3 Report Writer allows you to associate a specific form design with a report. When you select the report for printing, Sage 100 Contractor automatically selects the associated form design. In addition, you can determine the location of the report in Sage 100 Contractor. You can assign custom reports to 13-4 Report Printing, or to another window that contains reports similar to the custom report.

You can create new reports from scratch, or you can use existing reports as the basis for new reports. When you display a Sage 100 Contractor report, Sage 100 Contractor copies the report and displays the copy in the 13-3 Report Writer window. You can then edit, rename, and save the new report.

Scheduling Details

Tasks (Scheduling)

In the 10-2 Tasks window, you can create a master list of tasks. When creating a task list, it is important to tailor the tasks to the type of work your company performs and the level of detail necessary to effectively schedule projects.

In general, create tasks for every event that requires at least one day of work. To help create the task list, review the previous schedules of typical projects completed by your company. As you enter tasks, arrange the tasks in the order they are performed. For example, the tasks Rough Plumbing and Rough Electrical come before the task Pour Concrete Slab.

As you enter tasks, assign each task a task number. The sequence of task numbers should reflect the order in which tasks are performed. To allow for expansion of the task list, provide breaks in the sequence of task numbers as you create the list.

Task lists can vary in length and complexity. A general contractor, for example, might require more than 100 tasks whereas a subcontractor might require only 15 tasks. When creating the task list, consider the following:

Create tasks based on the type of work, not the person performing the work. You can assign resources to specific tasks after the client has approved the schedule.

Separate tasks. Some work is performed in stages and should be scheduled as different tasks. With separate tasks, you can also gain better control over resource allocation.

For example, a drywall subcontractor creates the tasks Stock Drywall, Hang Drywall, and Tape and Texture Drywall. Separate tasks allow the subcontractor to schedule resources needed for each task.

Combine tasks. Sometimes you can group a series of related tasks into a single task. Before combining tasks, consider what impact this will have on scheduling dependent tasks and resource allocation.
Suppose a general contractor is creating a task list for residential home construction. Because the drywall is always contracted out, the contractor creates two tasks: **Stock Drywall** and **Hang/Tape/Texture Drywall**. While the subcontractor has to schedule a variety of resources for the individual tasks, the contractor is only concerned with scheduling the subcontractor as a resource. Therefore, the general contractor can use a single task to schedule the hanging, taping, and texturing for drywall.

Create separate tasks for milestones, inspections, billings, or other important events.

**Service Receivables Details**

**Working with Service Receivables**

**Note:** Service Receivables features are available only if you have purchased the Service Receivables Add-On Module.

The Sage 100 Contractor **Service Receivables** add-on module handles service contracts, service routes, service dispatch, on-call work orders, quotes, and point-of-sale and billing-of-service work materials. Because **Service Receivables** fully integrates with the **Inventory** add-on module, you can keep inventory up-to-date based on service work completed.

Using **Service Receivables**, you can review information about equipment installed at multiple client sites and track how the equipment is used. You can use service truck inventory to assign parts to trucks or warehouses. In addition, you can turn your estimates into service work orders.

Here are more features found in Sage 100 Contractor **Service Receivables**:

- Estimates can be turned into single or multiple work orders.
- Billing can be done during or at the end of a job.
- Payroll hours can be imported from service work orders to payroll.
- Service dispatch can be displayed in 15-minute, hourly, or daily increments.
- Work orders can be displayed with user-defined color codes showing client, priority, and ZIP code.

**Service Work (Service Receivables)**

The **Service Receivables** add-on module handles service contracts, service routes, service dispatch, on-call work orders, quotes, and point-of-sale and billing-of-service work materials. Because **Service Receivables** fully integrates with the **Inventory** add-on module, you can keep inventory up-to-date based on service work completed.

Using **Service Receivables**, you can review information about equipment installed at multiple client sites and track how the equipment is used. You can use service truck inventory to assign parts to trucks or warehouses. In addition, you can turn your estimates into service work orders.

**Work Orders (Service Receivables)**

A work order is one step of the complete service receivables process. The general flow is from “quote” to “work order” to “invoice.” The service work process is quite flexible, however, and your business may use these capabilities in an abbreviated fashion.
Work orders can be set up and reviewed in a one-by-one fashion but can also be seen and manipulated in the dispatch board. The drag and drop capabilities of the dispatch board update times and assignments for work orders.

**Service Routes (Service Receivables)**

Regularly scheduled work, determined in the terms of the contract, is referred to as a service route. A route might entail routine inspection, maintenance, or performance of work.

For instance, a street sweeping company sweeps the parking lots for local shopping centers every week. On Mondays and Tuesdays, the company sweeps lots on the north side of town. On Wednesdays and Thursdays, the company sweeps lots on the west side of town. And on Fridays, the company sweeps lots on the south side of town. The lots swept on each day represent a different route.

**Service Locations (Service Receivables)**

For service work, you can set up a table of the different locations that you must service for each client. You can use the phone number of the location for quick lookup of clients.

**Contract (Service Receivables)**

Service receivables support a contract feature for recurring work using the contract data for recurring billing. Contracts can create invoices directly without creating a work order. Use the contract in situations where the same amount is billed each time. For each client, you may have multiple contracts.

**Dispatch Board (Service Receivables)**

Use 11-3 Dispatch Board to manage work orders and technician assignments. You can assign technicians to work orders, move work orders to different days, even delete work orders altogether. The Dispatch Board also displays travel time and appointments from the calendar. In fact, when you add time off to the Dispatch Board, it is added to the calendar.
Chapter 4: Customer Resources

Sage 100 Contractor Printable Documentation

Sage 100 Contractor and Your Business

*Sage 100 Contractor and Your Business* provides basic information about key relationships in your business and how they interact with Sage 100 Contractor. This book also explores Sage 100 Contractor’s underlying concepts for working with general ledger, accounts payable, accounts receivable, and more. In addition, you will find detailed information about Sage 100 Contractor general operational features, accounting, analysis, payroll, accounts receivable, accounts payable, and more.

Sage 100 Contractor Installation and License Administration Guide

The *Sage 100 Contractor Installation and License Administration Guide* provides explicit information about how to install Sage 100 Contractor and set up the software in your specific environment. It also provides information on how to set up and administer licensing. This guide is a “must read” for all systems administrators and business owners.

Sage 100 Contractor Product Overview

*Sage 100 Contractor Product Overview* provides background information to help you understand the core functionality of Sage 100 Contractor and how to use it to manage your business. If you are new to Sage 100 Contractor, we highly recommend that you read the specific background information about the tasks that you will perform. If you are a company owner or administrator, we recommend that you read all the information in this guide.

Sage 100 Contractor User Guide

The *Sage 100 Contractor User Guide* is a printable-PDF version of the Sage 100 Contractor Help. You will find that the Sage 100 Contractor User Guide is the most comprehensive yet. It provides extensive explanation of Sage 100 Contractor functions and tools as well as hundreds of procedures for completing tasks.

Sage 100 Contractor Database and Company Administration Guide

The *Sage 100 Contractor Database and Company Administration Guide* provides detailed information about the Database Administration for Sage 100 Contractor tool and how to use it to: create and maintain Sage 100 Contractor companies; control user and program access to your company database; migrate version 19.8 data and upgrade subsequent Sage 100 Contractor databases to the latest version; schedule maintenance and backup of your company data; and restore your company data from a backup copy.

Sage 100 Contractor Release Notes

The *Release Notes* document provides information about enhancements and previously reported issues in the software that have been resolved for the current release.

It also provides, where applicable, information and comments about recently discovered issues that have not yet been resolved before the latest software release.
Customer Support and resources

Important! Before you contact the Customer Support Call Center, take advantage of the following resources, which are available 24 hours a day, 7 days a week.

Sage 100 Contractor Help

From anywhere in the Sage 100 Contractor software, you can display this comprehensive library of accessible topics to learn more about specific procedures, topics, fields, or buttons.

Product documentation

The software comes with several PDF guides, including Release Notes, Installation and License Administration Guide, and User Guide, among others.

To view the guides, click Home & Resources tab > Product Documentation or, if you have Activity Centers hidden, click Resources > Printable Documentation.

Sage Knowledgebase

Depending on your Sage service plan, we offer a web-based Sage Knowledgebase and online user community forums at www.na.sage.com or through the in-product menu. Our staff maintains an extensive knowledge database of questions and answers covering everything from frequently asked questions to more complex problems and solutions. In addition, we keep all product reference documentation available in the Knowledgebase. This online tool is the same tool we use in our customer support call center to help answer your call.

To log in to the Sage Knowledgebase:

1. Go to https://support.na.sage.com/.
2. In the upper-right section of the page, above the Search, click Login.
3. Enter your Customer Portal Username and Password.
4. Click Log on.

Contacting Customer Support

Depending on your Sage service plan, you may be able to contact the Sage Customer Support Call Center to work with one of our highly trained customer support professionals. The Knowledgebase article How do I get technical support for Sage 100 Contractor? provides contact information and hours of operation, and it can help you to determine which service works best for you.

Our analysts work with you to respond accordingly to the urgency of your issue.

Call urgency can range from a simple explanation of software settings to critical situations in which work is stopped or data integrity is compromised. Some calls may warrant further research and followup, in which case our support analyst will place your call in his/her in-progress work list. At every step of the way, we work with you until we reach a resolution or agreement.
Depending on your Sage service plan, you may check the status or update, or even create a new support ticket online:

2. In the upper-right section of the page, above the Search, click Login.
3. Enter your Customer Portal Username and Password.
4. Click Log on.
5. On the right, select Submit a customer support case.

**Tip:** You can also click the [Live Chat] button Monday through Friday, from 9 am to 8 pm ET to start a conversation with a customer support analyst. The [Live Chat] button is available in the lower left corner of the Home window.

**Before you call customer support**

Be sure to have the following information on hand so we can handle your call efficiently.

<table>
<thead>
<tr>
<th>Question</th>
<th>How to Find the Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is your Sage client ID number?</td>
<td>Your client ID number can be found on correspondence you receive from Sage. If you do not know your Sage client ID, contact the person at your company who maintains your relationship with Sage.</td>
</tr>
<tr>
<td>What software version are you using?</td>
<td>To find the version, open Sage 100 Contractor; click Help &gt; About Sage 100 Contractor and note the number listed.</td>
</tr>
<tr>
<td>What application or area in the software are you calling about?</td>
<td>On the menu list, identify the application and window where are you are working (i.e. Selecting Invoices to Pay in 4-3-1, Accounts Payable Vendor Payments).</td>
</tr>
<tr>
<td>How can we help you?</td>
<td>Walk through the exact steps you completed with as much detail and accuracy as possible.</td>
</tr>
<tr>
<td>Is there an error message?</td>
<td>Write down the exact wording of the message.</td>
</tr>
<tr>
<td>Can you reproduce the issue?</td>
<td>Were you able to walk through the same steps that led to the problem and see whether it happened again?</td>
</tr>
<tr>
<td>Is this the first time the problem has happened? Does the problem occur on one workstation or several?</td>
<td>Ask other users if they have experienced the same problem. Have them test at their workstation to see if they experience the same problem. Also, have the original user try other workstations to see whether the problem is specific to that user.</td>
</tr>
<tr>
<td>Question</td>
<td>How to Find the Answer</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Has anything changed with your software, hardware, or workflow?</td>
<td>Ask your network administrator for technical information regarding anything that may have changed behind the scenes: upgrades to Sage 100 Contractor, new third-party software installations, moving of data from one server to another, new printers or print driver installation, or anything else that might affect the network.</td>
</tr>
<tr>
<td>Does the problem happen in the sample data sets?</td>
<td>Select [File&gt; Open Company], then change the drive letter on the dropdown to C:, select Sample Company.</td>
</tr>
<tr>
<td>What kind of network are you using?</td>
<td>If you do not know, contact your network administrator.</td>
</tr>
<tr>
<td>What printers and print drivers are installed?</td>
<td>If you do not know, contact your network administrator.</td>
</tr>
<tr>
<td>When was your last backup?</td>
<td>If you do not know, contact your network administrator.</td>
</tr>
</tbody>
</table>

**Training resources**

When you choose to take online classes from Sage or work with a Sage business partner, you will learn how to use Sage 100 Contractor to support your business. Contact your business partner to find out about training options or visit Sage University at [http://www.sageu.com](http://www.sageu.com).

**Online classes**

Online classes help you maximize your use of Sage 100 Contractor. Online classes are a convenient training option for your company and new users to learn more about Sage 100 Contractor so you can get the most out of the software. You can select from classes on all aspects of Sage 100 Contractor, including project management, estimating, scheduling, service management and payroll. Each online class is led by an instructor with years of experience using Sage 100 Contractor. During the class, you will be able to follow along as the instructor demonstrates functions and workflows in Sage 100 Contractor. In the online live session, you can ask questions and benefit from hearing answers to other students’ questions.

For more information, visit [http://www.sageu.com](http://www.sageu.com).

**Getting started as a new user**

We recommend that all new users should begin with our New Customer Training (NCT) series, which is included in our Essentials Training Package in recorded format for 24/7 access. If you prefer live online training led by an instructor, you can register for the Realtime Learning version of these NCT courses. For more information, visit [http://www.sageu.com](http://www.sageu.com).
**Business partners**

To serve you better, Sage 100 Contractor products and services are available to you through an authorized network of business partners. Business partners have local expertise and regional knowledge working with contractors in the region.

Your business partner is available to serve you, from simple how-to questions and hands-on demonstrations, to installation, implementation, and training. They’re fully equipped to help you get where you want to be. For more information, contact your Sage 100 Contractor business partner.

**Business forms**

Sage 100 Contractor is designed to work with generic checks and forms that are available from many sources. There is no single vendor that customers must use; however, you can get a complete portfolio of forms, tax forms, and checks through *Sage Construction and Real Estate Forms* by calling 800-760-7929 or by visiting [www.sagecreforms.biz](http://www.sagecreforms.biz).
# Index

## A

access rights
- company administrator 22

accounting
- accounts payable 8, 34
- accounts receivable 7
- equipment 9
- general ledger 7
- inventory 9
- payroll 8
- service receivables 9

accounts payable
- application
- accounts receivable 8

accounts receivable
- accounting 7

accrued sick leave
- carried forward 47

acct period 0
- accounting-related concepts 17

ACH
- about 61

administrator user 22

allocation
- inventory details 46

analysis
- query 10
- report writer 10

## API
- communications 12
- application
- accounts receivable details 42
- archive 20
- company 17, 20
- archive company
- functional details 20
- assembly estimating 44

## Attachments
- about 26
- attach Web links 28
- drag and drop files 26
- functionality 26
- network files 28
- parent-child 27
- printing 29
- uses 26

audit
- accounting details 31
- audit history 17

## B

benefits
- calculations 49

bid item
- estimating details 45

budget
- job-related concepts 15
<table>
<thead>
<tr>
<th>C</th>
<th>chart of accounts</th>
</tr>
</thead>
<tbody>
<tr>
<td>calculation types</td>
<td>accounting-related concepts 15</td>
</tr>
<tr>
<td>1-Deduct from Employee 56</td>
<td></td>
</tr>
<tr>
<td>2-Add to Gross 57</td>
<td>accounts receivable details 35</td>
</tr>
<tr>
<td>3-Employer Cost 58</td>
<td>clients</td>
</tr>
<tr>
<td>4-Add-Deduct 59</td>
<td>about 34</td>
</tr>
<tr>
<td>5-Accrued Hours 59</td>
<td>accounts receivable 34</td>
</tr>
<tr>
<td>calculations</td>
<td></td>
</tr>
<tr>
<td>adding 54</td>
<td>types 35</td>
</tr>
<tr>
<td>creating standard 51</td>
<td>close</td>
</tr>
<tr>
<td>in employee records 54</td>
<td>payroll</td>
</tr>
<tr>
<td>paygroup benefits 49</td>
<td>archive 20</td>
</tr>
<tr>
<td>pre-built standard 51</td>
<td>communications</td>
</tr>
<tr>
<td>setup 52</td>
<td>API 12</td>
</tr>
<tr>
<td>taxes</td>
<td></td>
</tr>
<tr>
<td>tables 55</td>
<td>email 12</td>
</tr>
<tr>
<td>types 56</td>
<td>fax 12, 20</td>
</tr>
<tr>
<td>calendar year-end</td>
<td>report scheduling 12</td>
</tr>
<tr>
<td>accounting details 32</td>
<td>company 20</td>
</tr>
<tr>
<td>California</td>
<td></td>
</tr>
<tr>
<td>Paid Sick Leave Act 47</td>
<td>company administrator 22</td>
</tr>
<tr>
<td>certified payroll reports 63</td>
<td>company archive 17</td>
</tr>
<tr>
<td>change order</td>
<td>company information 20</td>
</tr>
<tr>
<td>production 5</td>
<td>company information record</td>
</tr>
<tr>
<td>change orders</td>
<td>functional details 20</td>
</tr>
<tr>
<td>about 66</td>
<td>concepts</td>
</tr>
<tr>
<td>upgrade option 66</td>
<td>accounting-related</td>
</tr>
<tr>
<td></td>
<td>about 15</td>
</tr>
<tr>
<td></td>
<td>acct period 0 17</td>
</tr>
<tr>
<td></td>
<td>chart of accounts 15</td>
</tr>
<tr>
<td></td>
<td>controlling account 16</td>
</tr>
<tr>
<td></td>
<td>department 15</td>
</tr>
</tbody>
</table>
subaccount 16

job-related
  about 13
  budget 15
  cost code 13
  cost type 14
  division 14
  job 13
  job cost 14
  overhead 14
  phase 14

contract
  accounts receivable details 35
  service receivables details 73

contract amount
  accounts receivable details 36

controlling account
  accounting-related concepts 16

cost code
  job-related concepts 13

cost recovery
  equipment details 43

cost to complete
  about 68

cost type
  job-related concepts 14

costs
  jobs
    committed cost reports 67

credits
  receivable
    about 39
    recalculating 39

current period default
  accounting details 30

customer support
  knowledgebase 76
  Live Chat button 77

customers
  acquiring 1

D

daily field reports
  about 43

daily payroll
  about 59

Dashboard 11

Davis-Bacon Act 63

defaults
  customize 24
  functional details 24

department
  accounting-related concepts 15

details
  accounting
    audit 31
    calendar year-end 32
    current period default 30
division
   job-related concepts 14

document control
   production 6

drill down
   program-wide 11

E

e-mail
   communications 12

employee positions
   about 48

employees
   records
      about 46

equipment
   accounting 9

estimating
   assembly estimating 44
   relationships 2-3

export
   functional details 23

F

fax
   communications 12

features
   add-on modules 7
   document control 43

Sample Company 19

field properties
   functional details 23

final compute
   payroll details 62

fiscal year
   accounting details 31

fiscal year-end close
   accounting details 31

form designs
   13-5 Form-Report Page Design 68
   creating
      using existing forms 69
   editing
      existing 70
      previewing 70
      reducing display size 70

forms
   check 79
   tax 79

functional details
   archive company 20
   company information record 20
   defaults 24
   export 23
   field properties 23
   grids 25
   import 24
   lookup windows 25
   notes 25
Index

quick lists 25 ........................................
template 24 ........................................
user-defined fields 23 .........................
user name 23 ........................................

G
general contractor
  accounting details 29 .......................
general ledger
  accounting 7 .................................
grid files
  project management details 65 ..........
grids
  functional details 25 ....................
guides
  Database and Company Administration 75 
  Release Notes 75 ..........................
  Sage 100 Contractor and Your Business 75 
  User Guide 75 ...............................

H
home builder
  accounting details 29 ....................

I
import
  functional details 24 ....................
install
  component
    documentation 75 .......................
<table>
<thead>
<tr>
<th><strong>jobs</strong></th>
<th><strong>O</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>costs</td>
<td>Outlook 27</td>
</tr>
<tr>
<td>committed cost reports 67</td>
<td>over-under billing</td>
</tr>
<tr>
<td>jobs and job-costing</td>
<td>analysis details 32</td>
</tr>
<tr>
<td>job-related concepts 13</td>
<td>overhead</td>
</tr>
<tr>
<td>journal transaction</td>
<td>job-related concepts 14</td>
</tr>
<tr>
<td>accounting details 32</td>
<td><strong>L</strong></td>
</tr>
</tbody>
</table>

- liability 58 |
- Live Chat button 77 |
- local payroll taxes |
- about 55 |
- lookup windows |
- functional details 25 |

<table>
<thead>
<tr>
<th><strong>M</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>mail list</td>
</tr>
</tbody>
</table>
- about 34 |
| mailing list |
- about 34 |
| markup |
- estimating details 45 |
| methods |
| calculation 56-57, 59 |

<table>
<thead>
<tr>
<th><strong>N</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>notes</td>
</tr>
</tbody>
</table>
- functional details 25 |

<table>
<thead>
<tr>
<th><strong>P</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>part</td>
</tr>
</tbody>
</table>
- estimating details 45 |
| paygroups 48 |
- benefits 58 |
| payroll |
- accounting 8 |
- calculations |
- types 56 |
- paygroups 48 |
- posting 62 |
| taxes |
- certified payroll reports 63 |
| Payroll |
- close 32 |
| payroll calculations |
- create 51 |
| phase |
- job-related concepts 14 |
| posting |
- payroll 62 |
- about 62 |
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>posting period</td>
</tr>
<tr>
<td>accounting details 30 ..................................................................</td>
</tr>
<tr>
<td>change 17 ..................................................................................</td>
</tr>
<tr>
<td>pre-built standard payroll calculations 51 ..................................</td>
</tr>
<tr>
<td>prevailing-wage jobs</td>
</tr>
<tr>
<td>certified payroll report 63 ......................................................</td>
</tr>
<tr>
<td>prior year</td>
</tr>
<tr>
<td>accounting details 31 ..................................................................</td>
</tr>
<tr>
<td>production 3 ................................................................................</td>
</tr>
<tr>
<td>activities 3 ................................................................................</td>
</tr>
<tr>
<td>change order 5 ...............................................................................</td>
</tr>
<tr>
<td>document control 6, 43 ...................................................................</td>
</tr>
<tr>
<td>project management 6 .....................................................................</td>
</tr>
<tr>
<td>purchase order 4 ...........................................................................</td>
</tr>
<tr>
<td>request for proposal 5 ...................................................................</td>
</tr>
<tr>
<td>schedule 4 ....................................................................................</td>
</tr>
<tr>
<td>service management 5 .....................................................................</td>
</tr>
<tr>
<td>subcontract 5 ...............................................................................</td>
</tr>
<tr>
<td>profit</td>
</tr>
<tr>
<td>accounting details 32 ...................................................................</td>
</tr>
<tr>
<td>estimating details 45 ....................................................................</td>
</tr>
<tr>
<td>progress billing</td>
</tr>
<tr>
<td>about 40 ......................................................................................</td>
</tr>
<tr>
<td>Project Hot List</td>
</tr>
<tr>
<td>about 64 ......................................................................................</td>
</tr>
<tr>
<td>project management</td>
</tr>
<tr>
<td>production 6 ................................................................................</td>
</tr>
<tr>
<td>Project Work Center</td>
</tr>
<tr>
<td>about 63 ......................................................................................</td>
</tr>
<tr>
<td>proposals</td>
</tr>
<tr>
<td>relationships 3 ...........................................................................</td>
</tr>
<tr>
<td>purchase order</td>
</tr>
<tr>
<td>production 4 ................................................................................</td>
</tr>
<tr>
<td>query</td>
</tr>
<tr>
<td>analysis 10 ................................................................................</td>
</tr>
<tr>
<td>quick lists</td>
</tr>
<tr>
<td>functional details 25 ....................................................................</td>
</tr>
<tr>
<td>receivable clients 34 ....................................................................</td>
</tr>
<tr>
<td>relationships</td>
</tr>
<tr>
<td>accounting</td>
</tr>
<tr>
<td>about 6 .......................................................................................</td>
</tr>
<tr>
<td>analysis</td>
</tr>
<tr>
<td>about 10 .....................................................................................</td>
</tr>
<tr>
<td>communications</td>
</tr>
<tr>
<td>about 11 .....................................................................................</td>
</tr>
<tr>
<td>estimating 2-3</td>
</tr>
<tr>
<td>production</td>
</tr>
<tr>
<td>about 3 .......................................................................................</td>
</tr>
<tr>
<td>proposals 3</td>
</tr>
<tr>
<td>sales 2</td>
</tr>
<tr>
<td>remodeler</td>
</tr>
<tr>
<td>accounting details 30 ...................................................................</td>
</tr>
<tr>
<td>removing</td>
</tr>
<tr>
<td>paid and void invoices 33 ..........................................................</td>
</tr>
</tbody>
</table>
report
  direct deposit 61 .................................
report scheduling
  communications 12 ..............................
report writer
  analysis 10 ......................................
Report Writer
  about 70 ......................................
reports
  certified payroll 63 ............................
  committed cost 67 .............................
  drill down 11 .................................
request for proposal
  production 5 .................................
retention 40 .................................
  accounts receivable 40 ........................
  payable
    about 34 .................................
  receivable
    about 40 .................................

S
Sage 100 Contractor 1 ........................
Sage CRE
  cheques 79 .................................
  forms 79 .................................
sales
  relationships 2 .............................

Sample Company
  features 19 .................................
  user names and passwords 19 .............
sample reports
  analysis details 32 ........................
schedule
  production 4 .................................
schedules
  importing
    tasks 71 .................................
security
  company administrator 22 ...............
  features 20 .................................
  groups
    about 21 .................................
service locations
  service receivables details 73 ..........
service management
  production 5 .................................
  service receivables 72 ........................
  accounting 9 .................................
service routes
  service receivables details 73 ..........
service work
  service receivables details 72 ..........
shop
  equipment details 44 ........................
sick leave accrual
  carried forward 47 ........................
Index

maximum 47 ........................................
statement
accounts receivable details 39 ............................
subaccount
accounting-related concepts 16 ..........................
subcontract
production 5 ...........................................
subcontractor
accounting details 30 ...................................
subcontracts 26 ........................................
submittals
about 43 ................................................

T

task 71 ...................................................
tasks 71 ..................................................
about 71 .............................................
tax districts 42 .......................................  
about 42 .............................................
tax entities 42 ........................................
about 42 .............................................
taxes
districts and entities
about 42 .............................................
payroll
certified payroll reports 63 ..........................
tables
setup 55 .............................................

V

valuation methods
First In-First Out (FIFO) 46 ..........................
Last In-First Out (LIFO) 46 ..........................
Weighted Average Cost 46 ..........................

template
functional details 24 ..................................
time and materials billing
about 41 .............................................
timecard
payroll details 63 ..................................
training 13, 78 ......................................
getting started 78 ..................................
trial compute
payroll details 61 ..................................

U

union payroll
payroll details 60 .....................................
unitary billing
about 41 .............................................
upgrade
change orders 66 ...................................
user-defined fields
functional details 23 .................................
user name
functional details 23 .................................
users
company administrator 22 .........................

90 Sage 100 Contractor
vendors 33 ........................................
types 34 ........................................
Verify Check Date Is within Posting
  Period option 62 .............................
Verify Pay Period Ending Date Is within Posting
  Period option 62 .............................

W

WIP
  accounting details 29 ......................
work orders
  service receivables details 72 ............
workers’ comp classification
  payroll details 60 ...........................
workers’ comp split rates
  payroll details 60 ...........................

Y

year end
  calendar year 16 ............................
  more about 16 ..............................